Application Designer Quick Start Guide
First Edition (November 2006)
This edition applies to Release 6.2 of IBM Maximo and to all subsequent releases and modifications until otherwise indicated in new editions.

Third-Party Technology: Certain Maximo products contain technology provided under license from third parties, as noted in the following table:

<table>
<thead>
<tr>
<th>IBM Product</th>
<th>Third-Party Information</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximo Discovery</td>
<td>MSDE Copyright © Microsoft® Corporation.</td>
</tr>
<tr>
<td>IBM Maximo Mobile</td>
<td>Portions © 2005 DataMirror, Inc.</td>
</tr>
<tr>
<td>IBM Maximo Mobile SE</td>
<td>Portions © 1996-2005 Syelo, LLC.</td>
</tr>
</tbody>
</table>


© Copyright International Business Machines Corporation 2006. All rights reserved.

US Government Users Restricted Rights - Use, duplication or disclosure restricted by GSA ADP Schedule Contract with IBM Corp.
Contents

About This Guide ................................................................. v
  Audience ........................................................................... v
  Related Documentation ...................................................... v
  Support ............................................................................... v

Chapter 1: What Is Application Designer? ................................. 1-1
  User Interface Architecture ................................................ 1-1
    Controls .......................................................................... 1-2
    Presentation XML .......................................................... 1-2
    Process of Modifying the Presentation XML ....................... 1-4
    Exporting and Importing Presentation XML Files ............... 1-4
    Control Layout ................................................................ 1-4
    Editing XML Files .......................................................... 1-5
  Before Using Application Designer .................................... 1-5
    Setting Up an Environment .............................................. 1-5
    Usage Rules and Recommendations ................................. 1-6
  How to Add a Value List to a Field ..................................... 1-6
  Using Linked Objects and Crossover Domains ....................... 1-8
    Database Relationship and Crossover Domain Examples ...... 1-9
  Linked Objects and Crossover Domain Scenario .................... 1-9
  Displaying Information in an Application Using Linked Objects 1-12
    Adding Assetcomment Attribute to the ASSET Object ......... 1-14
    Running ConfigDB to Configure the Database .................. 1-15
    Linking the WORKORDER and ASSET Objects ............... 1-16
    Adding a Textbox for Assetcomment in Assets .................. 1-17
    Adding a Textbox for AssetComment in Work Order Tracking 1-20
  Displaying Information in an Application Using Crossover Domains 1-23
    How to Create and Apply a Crossover Domain .................. 1-26
    Adding Woassetcomment Attribute to the WORKORDER Object 1-26
    Adding a New Crossover Domain .................................... 1-27
    Applying the Crossover Domain ...................................... 1-29
    Adding a Textbox for Woassetcomment in Work Order Tracking 1-29
  How to Create Application Restrictions .............................. 1-32
  How to Duplicate an Application ....................................... 1-33
  How to Create a New Application ...................................... 1-33
  How to Lay Out a New Tab ............................................... 1-35
  How to Delete a User-Created Application .......................... 1-35
  How to Control the Size of Fields ..................................... 1-36
  How to Optimize the Placement of Input Fields for Data Entry 1-37
  How to Add Buttons and Select Action Menu Items .............. 1-37
  How to Define Signature Options for an Application .............. 1-37
  How to Assign and Override the Default Label Value for a Textbox Control 1-38
    Assigning a Value to a Default Label Field ...................... 1-38
    Overriding a Value in the Default Label Field .................. 1-39
  How to Define Default Values for Fields ............................ 1-39
  How to Define a Default Filter for a Table ........................ 1-40
  How to Modify Application Dialogs .................................... 1-41
  How to Move Controls Across Tabs .................................... 1-41
  How to Move Controls Across Applications ........................ 1-42
Appendix A: List of Signature Options .......................................................... A-1
  Common Signature Options. ................................................................. A-1

Appendix B: Controls Reference Information .............................................. B-1
  Appbar ................................................................. B-1
  Attachments ............................................................. B-2
  Blank Line .............................................................. B-3
  Button Group ............................................................ B-4
  Checkbox ............................................................... B-6
  Combobox ............................................................... B-10
  Data Source ............................................................. B-14
  Default Value ............................................................ B-18
  Help Grid ............................................................... B-20
  HyperLink ............................................................. B-22
  Image ................................................................. B-26
  Include ............................................................... B-28
  Listbox ............................................................... B-30
  Menubar ............................................................... B-33
  Multiline Textbox .......................................................... B-34
  Multipart Textbox ........................................................ B-39
  Parameter Value ........................................................ B-45
  Parameter Values ........................................................ B-47
  Pushbutton ............................................................. B-50
  Radio Button ............................................................ B-53
  Radio Button Group ........................................................ B-55
  Section ............................................................... B-59
  Section Column ........................................................ B-65
  Section Header .......................................................... B-66
  Section Row ............................................................ B-69
  Static Text ............................................................. B-69
  Tab ................................................................. B-72
  Tab Group ............................................................. B-75
  Table ............................................................... B-76
  Table Column .......................................................... B-82
  Textbox ............................................................... B-89
  Tree ............................................................... B-94
  Tree Attribute .......................................................... B-98
  Tree Node ............................................................. B-99

Index .............................................................................................. Index-1
About This Guide

This section briefly summarizes this document and how it can help you as an IBM® Maximo® user. It also provides information about other IBM resources available to you, such as additional documentation and support.

Audience

This guide provides a starting point for users who want to use Application Designer to create new applications or modify existing applications in Maximo.

Any user involved with configuring Maximo can benefit from reading this guide. All users should read the online help content for Application Designer before performing any of the steps outlined in this guide.

Related Documentation

For more information about *IBM Maximo Application Designer Quick Start Guide*, refer to the following documentation:

<table>
<thead>
<tr>
<th>Document</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>IBM Maximo Online Help</td>
<td>Provides step-by-step procedures for IBM Maximo applications.</td>
</tr>
<tr>
<td><em>IBM Maximo System Administrator's Guide</em></td>
<td>Describes database configuration, security, and other administrative level applications and tasks.</td>
</tr>
</tbody>
</table>

Support

IBM Maximo users with a valid Annual Customer Support Plan (ACSP) can obtain product support online at Support Online: support.mro.com.

Support Online includes information about product releases, software patches, and documentation updates. To find the most current version of a document, refer to the Knowledge Base on this site.
Application Designer is a tool that lets you configure the user interface for Maximo applications to meet your specific business needs.

The easy-to-use Application Designer interface enables you to change the appearance of Maximo applications without editing a line of code. The drag and drop functionality built into Application Designer greatly simplifies the process of using this tool.

Application Designer lets you perform the following common modifications to a selected application’s user interface:

- Moving fields and sections
- Adding new fields, tabs, and tables with columns and rows

Advanced capabilities include:

- Creating or duplicating applications
- Defining signature options
- Editing the Toolbar or the Select Action menu.

Although you can create a new or duplicate an existing application with this tool, you may need to perform the following additional activities to fully enable a new application:

- Create database tables and columns
- Define user access to the application
- Develop Java code
- Develop workflow processes

User Interface Architecture

The following sections discuss the user interface (UI) and general architecture of Application Designer, including the following topics:

- Controls
- Presentation XML (Extensible Markup Language)
- Process of modifying the presentation XML
- Exporting and importing presentation XML files
- Control layout
- Editing XML files
Controls

Maximo uses "controls," numerous pre-fabricated elements like tables and textboxes, to build the user interface for its applications. The individual controls are part of the Maximo code and cannot be modified. Some types of controls like sections act as containers for other types of controls, such as tab groups, textboxes, or static text. The behavior of each control depends on its binding to a Maximo business object (MBO) attribute. Attributes store values from the Maximo database that are referenced in a control.

The following table lists the controls available in Application Designer.

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Description</th>
<th>See...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Appbar</td>
<td>A container that displays all the applications, belonging to the current module, except for the currently displayed application.</td>
<td>page B-1</td>
</tr>
<tr>
<td>Attachments</td>
<td>An attachments icon that allows you to attach different types of information to a Maximo record, including images, spreadsheets, and Web pages.</td>
<td>page B-2</td>
</tr>
<tr>
<td>Blank Line</td>
<td>Inserts white space in a section.</td>
<td>page B-3</td>
</tr>
<tr>
<td>Button Group</td>
<td>A container for adding buttons.</td>
<td>page B-4</td>
</tr>
<tr>
<td>Checkbox</td>
<td>An HTML check box.</td>
<td>page B-6</td>
</tr>
<tr>
<td>Combobox</td>
<td>A combo box with drop-down functionality.</td>
<td>page B-10</td>
</tr>
<tr>
<td>Data Source</td>
<td>Miscellaneous type of control mostly used in Maximo dialogs</td>
<td>page B-14</td>
</tr>
<tr>
<td>Default Value</td>
<td>Forces a default value for a control that resides within a container.</td>
<td>page B-18</td>
</tr>
<tr>
<td>Help Grid</td>
<td>Help text displayed in dialog boxes.</td>
<td>page B-20</td>
</tr>
<tr>
<td>HyperLink</td>
<td>A hyperlink that supports both text and graphics.</td>
<td>page B-22</td>
</tr>
<tr>
<td>Image</td>
<td>Allows you to insert an image.</td>
<td>page B-26</td>
</tr>
<tr>
<td>Listbox</td>
<td>An open, drop-down menu that displays dynamic content.</td>
<td>page B-30</td>
</tr>
<tr>
<td>Menubar</td>
<td>A menu bar that contains signature options for the Search, Query, and Bookmark menus.</td>
<td>page B-33</td>
</tr>
<tr>
<td>Multiline Textbox</td>
<td>A text input box with multiple lines.</td>
<td>page B-34</td>
</tr>
<tr>
<td>Multipart Textbox</td>
<td>Two text boxes next to each other; one for displaying text and the other a description.</td>
<td>page B-39</td>
</tr>
<tr>
<td>Parameter Value</td>
<td>A container for the parameter value control to be used in sections and table windows.</td>
<td>page B-45</td>
</tr>
<tr>
<td>Parameter Values</td>
<td>This control contains the parameter values control which is a container for the parameter value control.</td>
<td>page B-47</td>
</tr>
<tr>
<td>Pushbutton</td>
<td>Individual buttons that belong to the button group.</td>
<td>page B-50</td>
</tr>
</tbody>
</table>
Maximo maintains information about the controls used to compose an application's user interface in XML format, and stores this information in the database. Maximo assigns a unique ID to each control used in an application, and Application Designer accesses these controls by referencing their unique IDs.

When you run MAXINST to create the Maximo database, the install program places the presentation XML content in the MAXPRESENTATION table.

Every application’s presentation XML has a tag for each control it uses to build the user interface. Each tag has a series of attributes, and their values determine how the control behaves when you view the application. The location of the tags in an application’s XML presentation relative to other tags determines the order and sequence of the user interface elements that you see in a screen.
When you access an application, Maximo retrieves the application’s XML code from the database and stores it in the application server's memory. For each control referenced in the XML, the user interface framework of Maximo fetches that control’s code. Based on the values of the attributes passed to it in the XML, Maximo builds the HTML description of the element that the control represents in memory. The application server holds all tags in memory while Maximo incrementally builds the complete HTML description for a screen. Once completed, the application server passes the HTML from the application server to the client (user’s Web browser). The XML remains in the server's cache and waits for the next time a user accesses the application.

**Process of Modifying the Presentation XML**

When you display an application in Application Designer, Maximo loads its presentation XML in memory. When you edit the application by moving, adding, and changing attribute values and deleting controls, Application Designer edits the XML in memory to reflect changes you make.

When you save an application, the application server saves the XML in memory to the database. Additionally, when you next use that application, the server loads the XML from the database and renders the application in a browser window.

**NOTE** Controls that represent user interface elements carried over from versions of Maximo earlier than 6 have an ID that loosely corresponds to the JSP tag structure in the first Web-based version of the product. The difference in control ID's from 5.x to 6 will make it easier to identify user interface elements when comparing 5.x to 6 screens.

**Exporting and Importing Presentation XML Files**

You have to use Application Designer to export XML presentation information to a physical file that you can save. This feature enables you to transport application screens from one environment to another, such as from development to production.

Exporting an XML presentation to a file also lets you edit the XML directly with a text editor rather than with Application Designer. For example, a title modification that applies to all screens is easier to do with the search and replace functionality of a text editor rather than editing each application screen using Application Designer as the user interface editor.

**NOTE** If you manually edit an XML file, you must load that file to the database for changes to take effect using the Import File Definitions feature.

Limit your XML edits to simple changes, such as modifying labels, to ensure that changes migrate with subsequent upgrades of Maximo.

**Control Layout**

The positioning of controls in the Maximo user interface is completely relative. The user interface is neither pixel based nor is it grid based as in 5.x releases. There are no set locations where controls can live on a screen. The exact placement location of a control is relative to other controls on the screen. The
relative aspect of the spacing also provides for dynamic sizing of a section's columns and overall width. For example, a section that contains fields of various widths will automatically size itself relative to the largest field (widest) in that section.

**Editing XML Files**

There are times when editing the XML file of a presentation is more efficient than using Application Designer to make changes. In some cases, the only way for you to make a desired change to a presentation is to edit system level XML code.

If you want to make a presentation change by editing XML code, you must first use the export function in Application Designer to export the desired application's XML code to a file. Once exported, you must save the file to a local directory, and then edit that file with a simple text editor. Once completed, you can import the modified XML file using the import function of Application Designer.

**Before Using Application Designer**

This section of the document provides pointers about setting up a client machine and the general system environment before using Application Designer.

**Setting Up an Environment**

Before using Application Designer, please consider the following recommendations:

- To optimize the amount of information you can view with your monitor without scrolling, set your resolution to 1280x1024.

- A higher resolution makes it easier to keep floating dialog boxes, like the Control Palette and Control Properties, outside of the configurable screen area of the application.

- Employ three separate environments — development, staging, and production — for designing, testing, and deploying changes made with Application Designer.

For example, the development environment can be on your own dedicated workstation where you can make configuration changes using Application Designer. The staging environment can be a server machine where you merge and test individual configurations created in the development environment. After staging, you migrate the changes to your production environment so that they are available to all users.

Employing a multi-stage model insulates your production environment from configuration changes made in development and staging.
Usage Rules and Recommendations

You should familiarize yourself with the following rules and recommendations when using Application Designer:

1. Only one user should edit an application on the same server.

2. Create the data source and associated objects for a new application in Database Configuration before creating screens with Application Designer.

3. You can only delete user-created or duplicated applications. You cannot delete applications shipped with the product.

4. When you drag a control from the palette onto the workspace, Application Designer positions the control to the top and left of the target control. Target controls are highlighted with a yellow background color.

5. You can drag most controls into container type controls, such as a section or table.

6. The package key you use when installing Maximo determines what applications you can edit with Application Designer.

The following sections provide information on how to perform common application configuration tasks using Application Designer and other Maximo configuration applications, such as Database Configuration and Domains.

How to Add a Value List to a Field

Maximo uses domains to limit the choice of values that you can enter in a field or to filter what values that can display in a list. To add a domain to a field, you need to perform the following tasks:

▼ Use the Domains application to create a new domain.

▼ Use Database Configuration to create a new attribute and to associate the new domain with it.

▼ Configure the database.

▼ Use Application Designer to add a textbox with a lookup list to the user interface and to bind the textbox to the attribute you created in Database Configuration.

The following example shows how you use Application Designer to add a textbox control to the Assets application with a lookup that lets you identify your company's assets as being in a state of: ACTIVE, PENDING, or INACTIVE.

1. Open the Domains application by choosing Go To > Configuration > Domains.

2. Click Add New Domain > Add New ALN Domain.
3 Enter "Assetstatus" in the Domain field, "Asset Status" in the Description field, "UPPER" in the Data Type field, and "8" for the Length.

4 In the ALN Domain screen, click New Row, and enter "ACTIVE" in the Value and Description fields.

5 Repeat Step 4, and enter values of "ENDING" and "INACTIVE."

6 Click OK, and then click Save.

7 Open the Database Configuration application by choosing Go To > Configuration > Database Configuration.

8 Type "ASSET" in the Object field, and press Enter.

9 Click on "ASSET" to open the object record.

10 Click the Attributes tab, and then click New Row.

11 Enter "STATE" in the Attribute field, and then enter the following values:
   - "UPPER" in the Type field
   - "8" in the Length field
   - "Activity State" in the Title field
   - "INACTIVE" in the Default Value field
   - "ASSETSTATUS" in the Domain field

12 Click Save.

13 To save the changes to your database, complete the following:
   - Sign out of Maximo.
   - Shut down the application server (Ctrl + C), and then wait a minute.
   - Open a command shell (Start > Run > cmd), and navigate to the <maximo_root>\tools\maximo directory.
   - Run configdb.bat.
   - Refer to the IBM Maximo System Administrator’s Guide for additional details on configuring the database.
   - Restart the application server, and login to Maximo.

14 Open Application Designer application by choosing Go To > Configuration > Application Designer.

15 Type "ASSET" in the Application field, and press Enter.

16 Click on ASSET to open the Assets application in the AD workspace.

17 Click the Asset tab.

18 Click on the Control Palette icon.
Click on the Section label that holds the Asset and Status fields. The section background turns green.

Drag and drop the textbox control on top of the Asset field. Notice that the input box displays "INVALID BINDING" because the control is not bound to a data field.

Select the textbox control (the background turns green), and click the Control Properties icon.

Type "STATE" in the Attribute field, and press Tab. Note that the text box field becomes bound and its label changes to Activity State (which is the description you entered when you first created the attribute).

Type "VALUELIST" in the Lookup field, and press Tab. Note that the AD adds a lookup icon next to the field so that Activity State will now show a list of values (e.g., ACTIVE, PENDING, and INACTIVE) during lookup.

Click Save.

Open the Assets application by choosing Go To > Assets > Assets and open an asset in the Asset tab to view your changes.

The preceding example is a generic way to create simple value lists. You can view more application-specific value list presentations in lookups.xml in the `<maximo_root>`\resource\presentations\system directory. You can add more or modify the existing value lists by editing the contents of this file with a text editor.

If you edit lookups.xml or any other presentation-related XML file, you will need to import the presentation file into the database by using the Import Application Definition button, which is available from both the Applications and Workspace tabs of Application Designer.

Creating linked objects and crossover domains represent different configuration mechanisms that you can employ in Maximo to move data from one field in an application to another field in a different application. The term source refers to an originating field or application. The term destination refers to a target field or application.

Although similar in purpose, there are distinct differences as to how these configuration mechanisms transfer data across applications. Linked objects, for example, can pass data from a source application to a target application using database relationships. In the destination application, the data value can be read only or read/write depending on how you configure the input field. If you configure the destination input field to be read/write, then Maximo automatically updates the source application and parent object if you update a displayed value.

Crossover domains, alternatively, pass data from one application to a different application using domains. Maximo passes a copy of the data value from a source application to a destination application using the crossover domain as
a trigger mechanism. You cannot edit the data value in the destination application. The copied data value is essentially static.

Database Relationship and Crossover Domain Examples

Database relationships that link objects and crossover domains let you export information from a defined source object to a different destination object using List and Validation Where Clauses to filter values. You might, for example, use a database relationship or crossover domain to accomplish the following:

- Enter an asset number in the Items application and have Maximo retrieve the asset’s serial number from the ASSET object and copy it into a field.
- Enter an asset number for a new work order and have Maximo retrieve the parent asset number from the ASSET object and insert it into a field.
- Enter the user name for a person creating a material receipt record and have Maximo retrieve the name of the user’s supervisor from the PERSON object and insert it into a field.
- Enter a user name in a Maximo application and have Maximo retrieve the user’s phone number and address from the PERSON object and insert it into two different fields.
- Enter an asset number for a new work order and have Maximo retrieve "comments" about the item from the ASSET object and copy to a textbox field in the work order.

You can configure an existing field or you can create an entirely new field(s) in a destination application using Application Designer to display information that derives from linked objects or a crossover domain. If you decide to add fields that do not have a corresponding database attribute, you must add the new attributes to the source and destination objects using Database Configuration.

Linked Objects and Crossover Domain Scenario

Because linking objects and creating crossover domains have similar objectives, you must first decide what it is you want to accomplish from a business practice before you choose one method over the other. For example, you decide that you want to add a field to the Asset application that holds important comments about an asset. A comment field is not a description but a remark similar to "John Doe is monitoring this motor. Please contact him before you perform any maintenance." Further, you want the comments field to display in the work order screen whenever you add an asset to a work order.

You have two options:

1. Make comments a read only field in Work Order Tracking. It is a "reference only" field that users cannot update in the work order screen. Similarly, make comments a read/write field in Work Order Tracking.
Linked Objects and Crossover Domain Scenario

Users can update the field in the work order screen, which will automatically update the comments attribute in the ASSET object.

2. Copy the comments field value from the ASSET object to an editable field on the work order. Any changes you make to the comments field in the work order will not update the comments attribute. Similarly, any subsequent changes to the comments attribute in the ASSET object are not passed to the comments field in the work order.

You can accomplish Option 1 using linked objects. You can accomplish Option 2 with a crossover domain.
The following table summarizes the actions you must perform to complete the two different scenario options.

<table>
<thead>
<tr>
<th>Option 1 (linked objects)</th>
<th>Option 2 (crossover domain)</th>
</tr>
</thead>
<tbody>
<tr>
<td>1) Add assetcomment attribute to the ASSET object in Database Configuration</td>
<td>1) Add assetcomment attribute to the ASSET object and woassetcomment attribute to the WORKORDER object in Database Configuration</td>
</tr>
<tr>
<td>2) Configure your database</td>
<td>2) Configure your database</td>
</tr>
<tr>
<td>3) Add new relationship to the WORKORDER object in Database Configuration (asset2wolink)</td>
<td>3) Create new crossover domain in Domains (asset2wo)</td>
</tr>
<tr>
<td>4) Add textbox control for assetcomment attribute to Assets in Application Designer Set Label to Comments</td>
<td>4) Add crossover domain to workorder.assetnum (the &quot;trigger field&quot;) in the WORKORDER object in Database Configuration</td>
</tr>
<tr>
<td>5) Add new asset in Assets and enter &quot;John Doe is monitoring this motor&quot; in the Comments field</td>
<td>5) Configure your database</td>
</tr>
<tr>
<td>6) Add textbox control for &lt;database relationship name&gt;.assetcomment attribute to Work Order Tracking in Application Designer</td>
<td>6) Add textbox control for assetcomment attribute to Assets in Application Designer Set Label to Comments</td>
</tr>
<tr>
<td>7) Configure Input Mode for &lt;database relationship name&gt;.assetcomment to READONLY</td>
<td>7) Add new asset in Assets and enter &quot;John Doe is monitoring this motor&quot; in the Comments field</td>
</tr>
<tr>
<td>8) Configure Input Mode for &lt;database relationship name&gt;.assetcomment to DEFAULT (Read/Write)</td>
<td>8) Add textbox control for woassetcomment attribute to Work Order Tracking in Application Designer</td>
</tr>
<tr>
<td>(OR)</td>
<td>9) Input Mode, regardless of setting, is always Read Only in this scenario.</td>
</tr>
</tbody>
</table>

The following sections provide detailed descriptions of the steps you must perform to configure Maximo to display comments about an asset in a work order using one of the following scenarios:

- Using linked objects to display "comments" for an asset in Work Order Tracking
- Using crossover domains to display "comments" for an asset in Work Order Tracking
Displaying Information in an Application Using Linked Objects

The user interface for a Maximo application uses controls that bind to database attributes that present data from an application’s parent or children objects in a browser window. The Work Order Tracking application, for example, uses WORKORDER as its parent object and ASSET as a child object.

Because most applications need to present data that resides in other objects, you use Database Configuration to define "relationships" between objects. The relationships you create between objects enable data from related tables to be available to the parent object and subsequently to your application.

The Work Order Tracking application, for example, needs to display data stored in the ASSET object. The following example describes the steps you must perform to capture user comments about a particular asset when adding that asset to a work order. The procedures in this section describe the following steps you must perform:

1. Add assetcomment attribute to the ASSET object
2. Configure the Maximo database
3. Create a database relationship between ASSET and WORKORDER objects using Database Configuration (Write down the relationship name, for example, ASSET2WOLINK, for future reference)
4. Add a textbox control for the assetcomment attribute to Assets using Application Designer
5. Add an asset in Assets with comment information
6. Add a textbox control for the $database relationship$.assetcomment attribute to Work Order Tracking using Application Designer (where $database relationship$ is the name of the relationship created in Step 3)
Displaying Information in an Application Using Linked Objects

The following diagram shows the process flow for capturing comments about an asset when entering an asset number on a work order using linked objects.

**Displaying Asset Comments in Work Order Tracking by Linking Objects**

1. Add assetcomment attribute to ASSET object
2. Configure the Maximo database
3. Add ASSET2WOLINK database relationship to WORKORDER object in Database Configuration. Enter Validation Where Clauses. (Binds objects and finds unique asset record)
4. Add textbox control for assetcomment attribute to Assets in Application Designer
5. Add textbox control for assetcomment attribute (Label = Comments and Attribute = asset2wolink.assetcomment) to Work Order Tracking application in Application Designer
6. Enter the Asset # (ASSETNUM) in Work Order Tracking to trigger the database relationship condition for the ASSET and WORKORDER objects
Adding Assetcomment Attribute to the ASSET Object

You must add an attribute (if one does not already exist) to the ASSET object as the first step in capturing user comment information about an asset.

Complete the following steps to add the assetcomment attribute to the ASSET object:

1. Open Database Configuration by choosing Go To > Configuration > Database Configuration.

2. In the search filter on the List tab, type ASSET in the Object field, and press Enter.

3. Click ASSET to open the detail record for the Asset table in the Object tab.

4. Click the Attributes tab.

5. Click New Row to display the Details section for adding a new attribute.

6. Enter or accept the defaults for the following required fields:

<table>
<thead>
<tr>
<th>Field Label</th>
<th>Input Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Assetcomment</td>
<td>Attribute name</td>
</tr>
<tr>
<td>Description</td>
<td>User comments regarding the asset</td>
<td>Text description of attribute</td>
</tr>
<tr>
<td>Type</td>
<td>ALN</td>
<td>The default</td>
</tr>
<tr>
<td>Length</td>
<td>100</td>
<td>Field length</td>
</tr>
<tr>
<td>Title</td>
<td>Comment</td>
<td>Alias name to substitute in messages and screen labels</td>
</tr>
<tr>
<td>Search Type</td>
<td>Wildcard</td>
<td>Wildcard lets you search on this attribute using wild card characters like * and %</td>
</tr>
</tbody>
</table>

7. Click Save.
Displaying Information in an Application Using Linked Objects

The Status of the new attribute changes to Add. The status of the ASSET object changes to To Be Changed.

**NOTE** Saving a change in Database Configuration stores the update in a configuration table. It does not implement the change in the database. You must run the ConfigDB batch file to update the database.

**Running ConfigDB to Configure the Database**

Before you continue with linked objects and the process of making asset comments available on work orders, you must run ConfigDB to add the assetcomment attribute to your database.

As a safety measure, back up your existing database before you run ConfigDB. When you run the database configuration program, it automatically configures and restores data in one step. Also, close all open applications before running ConfigDB, including the following:

- Maximo Application Server (Use Ctrl+C from a command line or Windows Services Administration if running as a service)
- Actuate Server and all third-party tools that might access the database, such as SQL*Plus or Microsoft Excel

Complete the following steps to configure your database:

1. Open Database Configuration by choosing Go To > Configuration > Database Configuration.

2. From the Select Action menu, select Apply Configuration Changes. Maximo displays a message reminding you to apply configuration changes to the database using ConfigDB from the command line.

3. Click OK, then sign out of Maximo and any other open applications. Wait 60 seconds to ensure that any user sessions terminate properly.

4. Open a Command Prompt window. From a Windows operating system, choose Start > Run.

5. Type cmd in the Run dialog box, and press Enter.

6. Navigate to the following directory:

   `<maximo_root>\tools\maximo`
7. Type ConfigDB to configure the database and restore backup tables. When the configuration process completes, you will see the message:

```
RestoreFromBackup completed [Date/Time stamp]
```

8. Type exit at the command prompt, and press Enter to close the window.

To review the log file for the database configuration, navigate to the following directory:

```
<maximo_root>\tools\maximo\log
```

Open the "ConfigDB..." log file with the most recent date/time stamp. You will see a statement similar to the following:

```
alter table asset add assetcomment varchar2 (100) null
```

### Linking the WORKORDER and ASSET Objects

To capture comments associated with an asset on a work order, you must create a relationship or link between the WORKORDER and ASSET objects. The link enables Work Order Tracking to display and/or update information stored in the ASSET object.

Complete the following steps to create a relationship between the WORKORDER and ASSET objects:

1. Open Database Configuration by choosing Go To > Configuration > Database Configuration.
2. Type WORKORDER in the Object field, and press Enter.
3. Click WORKORDER to open the Work Order screen.
4. Click the Relationships tab, and then click New Row to open the Details screen.

**WORKORDER Relationships Details Screen**

Complete the information on this screen to add a database relationship that binds the WORKORDER and ASSET objects using one or more Where Clauses. The Where Clause(s) state the conditions under which the two objects can join. In this example, the Where Clauses ensure that Work Order Tracking returns a unique record value from the ASSET object when you enter an asset number in a work order.
5 Type the following information:

<table>
<thead>
<tr>
<th>Field Label</th>
<th>Input Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Relationship</td>
<td>ASSET2WOLINK</td>
<td>The name of the database relationship</td>
</tr>
<tr>
<td>Child Object</td>
<td>ASSET</td>
<td>The name of the child object. WORKORDER is the parent object.</td>
</tr>
<tr>
<td>Where Clause</td>
<td>assetnum=:assetnum and siteid=:siteid</td>
<td>SQL Where Clause condition(s). Maximo does not validate your input in the Where Clause field. Verify that your syntax is correct.</td>
</tr>
<tr>
<td>Remarks</td>
<td>&lt;text&gt;</td>
<td>Enter a description of the relationship. For example:</td>
</tr>
</tbody>
</table>

The following table describes the logic of the Where Clause conditions for this example:

<table>
<thead>
<tr>
<th>Where Clause Syntax</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>:assetnum</td>
<td>Represents asset number value entered in work order screen</td>
</tr>
<tr>
<td>assetnum=</td>
<td>Look in ASSET object for the asset number that matches the value entered in the work order screen</td>
</tr>
<tr>
<td>:siteid</td>
<td>The Site value entered in work order screen</td>
</tr>
<tr>
<td>siteid=</td>
<td>Look in ASSET object for the Site value that matches the current value in the work order screen</td>
</tr>
</tbody>
</table>

The Where Clause above joins the WORKORDER and ASSET objects and locates a unique record.

6 Click Save.

To complete the process of capturing asset comment information on work orders, continue to the next procedure that describes how to add a textbox control to Work Order Tracking in Application Designer.

Adding a Textbox for Assetcomment in Assets

Complete this procedure to add a textbox control to Assets using Application Designer. The textbox lets you input or edit a comment value for an asset. For example, you might enter the comment "John Doe is monitoring this motor..."

Before you start, verify that you have completed the following task:

- Added assetcomment attribute to the ASSET object

Complete the following steps to add a textbox control to Assets.
1. Open Application Designer by choosing Go To > Configuration > Application Designer.

2. Type ASSET in the Application search field, and press Enter.

3. Click ASSET to open Assets in the Workspace tab.

4. Select the Asset tab.

5. Click the section that holds the Asset field.

**Asset Section of Assets in Application Designer**

6. Click the Control Palette button to open the Controls palette.

7. Drag the Textbox control into the Asset section.

**Textbox Control Dropped into Section with Asset Number Field**

8. With the Textbox control selected, click the Control Properties button to open the Textbox Properties dialog box.

9. Enter the following information to bind the Textbox control to the assetcomment attribute:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Label</td>
<td>Defaults to Comment</td>
<td>When you specify assetcomment in the Attribute field, this field defaults to the attribute's default label value (if available). You can assign your own label value for this attribute that is specific to the application in the Label field. For example, you might enter Asset Comments.</td>
</tr>
<tr>
<td>Label</td>
<td>Comments</td>
<td>The value you enter here, for example, Comments, overrides the Default Label setting within the application. The value you enter for Label is specific to the application and not stored in an object.</td>
</tr>
</tbody>
</table>
The completed Textbox Properties dialog box appears below.

**Textbox Properties Dialog Box**

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>assetcomment</td>
<td>The name of the asset comment attribute in the ASSET object.</td>
</tr>
<tr>
<td>Input Mode</td>
<td>DEFAULT</td>
<td>The Default option configures the Input Mode for the Comment field to be Read/Write or &quot;edit&quot; mode.</td>
</tr>
</tbody>
</table>

10 Click Save.

The following graphic illustrates how the Asset section appears with a configured textbox field for assetcomment.

**Asset Section with Comments Field in Assets**

The following section describes the next step of configuring your database.
Adding a Textbox for Assetcomment in Work Order Tracking

Complete this procedure to add a textbox control in Work Order Tracking using Application Designer. The textbox displays the assetcomment attribute value when you enter an asset number in a work order.

Before you start, verify that you have completed the following tasks:

- Added assetcomment attribute to the ASSET object
- Configure your database
- Added a database relationship (ASSET2WOLINK) to the WORKORDER object
- Added textbox control for assetcomment to Assets in Application Designer (Must subsequently enter a comment for a new or existing asset, for example, "John Doe is monitoring this motor...")

You can configure the Input Mode property of a textbox control in Work Order Tracking to a number of different settings. For this example, you can set the Input Mode to Default, which is Read/Write. Alternatively, you can set the value to Read Only. Setting the comments field to Read/Write updates the assetcomment attribute whenever you edit the attribute value in Work Order Tracking. The Read Only setting displays, but does not let you update, the comment value in the work order application.

Complete the following steps to add a textbox control to Work Order Tracking using Application Designer.

1. Open Application Designer by choosing Go To > Configuration > Application Designer.
2. Type WOTRACK in the Application search field, and press Enter.
3. Click WOTRACK to open Work Order Tracking in the Workspace tab.
4. Select the Work Order tab.
5. Click the section that holds the Asset field.
Displaying Information in an Application Using Linked Objects

**Asset Section of Work Order Tracking in Application Designer**

6. Click the Control Palette button to open the Controls palette.

7. Drag the Textbox control on top of the Parent WO field to position the control between the Asset and Parent WO fields.

*Textbox Control Dropped into Section with Asset Number Field*

8. With the Textbox control selected, click the Control Properties button to open the Textbox Properties dialog box.

9. Enter the following information to bind the Textbox control to the assetcomment attribute:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Label</td>
<td>Defaults to Comment</td>
<td>When you specify assetcomment in the Attribute field, this field defaults to the attribute’s default label value (if available). You can assign your own label value for this attribute that is specific to the application in the Label field. For example, you might enter Asset Comments.</td>
</tr>
<tr>
<td>Label</td>
<td>Comments</td>
<td>The value you enter here, for example, Comments, overrides the Default Label setting within the application. The value you enter for Label is specific to the application and not stored in an object.</td>
</tr>
</tbody>
</table>
Displaying Information in an Application Using Linked Objects

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>asset2wolink.assetcomment</td>
<td>Type the name of the asset comment attribute in the ASSET object. You must preface the assetcomment attribute with the name of the database relationship that binds the ASSET and WORKORDER objects and a dot. For example, asset2wolink.assetcomment.</td>
</tr>
<tr>
<td>Input Mode</td>
<td>DEFAULT or READONLY</td>
<td>The Default option configures the Input Mode for the Comment field to be Read/Write or &quot;edit&quot; mode. You can also configure the Comment field to be Read Only.</td>
</tr>
</tbody>
</table>

The completed Textbox Properties dialog box appears below.

Textbox Properties Dialog Box

The following graphic illustrates how the Asset section of a work order might appear with a populated Comments field.

10 Click Save.

The following graphic illustrates how the Asset section of a work order might appear with a populated Comments field.
Asset Section with Comment Field in Work Order Tracking

At this point, Maximo populates the Comments field whenever you add an asset record to a work order.

The following sections describe how to modify Work Order Tracking using a crossover domain.

Displaying Information in an Application Using Crossover Domains

Using a crossover domain to display comments about an asset in Work Order Tracking is similar to using linked objects except that you use a crossover domain value to establish a link between the WORKORDER and ASSET objects and not a database relationship. Additionally, the asset comment that displays in a work order is a copy of the woassetcomment attribute at the time you add an asset number to the work order. When using a crossover domain to copy data across applications, you cannot edit the asset comment value in the destination application.

Because most Maximo applications need to present data that resides in other objects, you need to use Database Configuration or Domains to define links between objects. You define the parent and child objects, the trigger fields, and the conditions (SQL Where Clauses) that bind two objects. The relationships you create between objects enable data from related tables to be available to the main object and subsequently to your application.

The Work Order Tracking application, for example, needs to display data stored in the Asset object. The following scenario describes the process of capturing user comments about a particular asset when adding that asset to a work order using a crossover domain. Creating and applying a crossover domain includes the following steps:

1. Add assetcomment attribute to ASSET object and woassetcomment to WORKORDER object
2. Configure the Maximo database
3. Add ASSET2WO crossover domain using Domains
Displaying Information in an Application Using Crossover Domains

4. Add ASSET2WO crossover domain to WORKORDER woassetcomment attribute using Database Configuration

5. Configure the Maximo database

6. Add a textbox control for woassetcomment to Work Order Tracking using Application Designer

7. Enter an asset number on a work order
The following diagram shows the process flow for capturing comments about an asset when entering an asset number on a work order using a crossover domain.

**Displaying Asset Comments in Work Order Tracking Using a Crossover Domain**

1. Add assetcomment and woassetcomment attributes to the ASSET and WORKORDER objects.
2. Configure the Maximo database.
3. Create ASSET2WO crossover domain in Domains. Specify assetcomment as Source field and woassetcomment as the Destination field. Enter Validation Where Clauses. (Finds unique record in ASSET object)
4. Add ASSET2WO crossover domain to the woassetcomment attribute in the WORKORDER object using Database Configuration.
5. Configure the Maximo database.
6. Add textbox control (Label = Comments) for woassetcomment attribute to Work Order Tracking in Application Designer (AD).
7. Enter the Asset # (ASSETNUM) in Work Order Tracking to trigger the ASSET2WO crossover.

---

Run configdb.bat

Look in ASSET object for the Asset number that matches the value entered in WO screen

The Asset number value (e.g. 341) entered in WO screen

Look in ASSET object for the Site value that matches the current value in WO screen

The Site value (e.g. Bedford) entered in WO screen

Set Filter = ASSETNUM for woassetcomment attribute

Set Domain = ASSET2WO in ASSETNUM details section

Static copy of woassetcomment value (does not get updated if assetcomment value changes)
How to Create and Apply a Crossover Domain

A crossover is a mechanism that Maximo uses to copy data from a child object to a parent object based on a value you enter in an application's user interface. You might build a crossover, for example, to accomplish the following:

- Copy the supervisor’s name for a user who creates a material receipt to the newly created record.
- Copy the phone number and address of a person after you enter their name in an application.
- Copy the parent asset number (asset.assetnum) or asset comments (asset.assetcomment) to a work order after you enter the asset number in a new work order record.

Creating and applying a crossover is a multi-step process. The following set of procedures describe how to employ a crossover to copy asset comments to a new work order record.

The WORKORDER object manages work order records and can store information about a work order from related objects like ASSET. A typical work order record stores asset numbers, and when employing the crossover domain used in this example, asset comments.

The crossover enables Maximo to retrieve and save comments about an asset in the WORKORDER object when you add an asset number to a work order.

Adding Woassetcomment Attribute to the WORKORDER Object

The first step in capturing user comment information about an asset is to add an attribute (if one does not already exist) to the ASSET object that will store comment information. See "Adding assetcomment attribute to the ASSET object" for a detailed procedure.

Complete the following steps to add the woassetcomment attribute to the WORKORDER object:

1. Open Database Configuration by choosing Go To > Configuration > Database Configuration.
2. In the search filter on the List tab, type WORKORDER in the Object field, and press Enter.
3. Click WORKORDER to open the detail record for the Work Order table in the Object tab.
4. Click the Attributes tab.
5. Click New Row to display the Details section for adding a new attribute.
6 Enter or accept the defaults for the following required fields:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Woassetcomment</td>
<td>Attribute name</td>
</tr>
<tr>
<td>Description</td>
<td>User comments regarding the asset</td>
<td>Text description of attribute</td>
</tr>
<tr>
<td>Type</td>
<td>ALN</td>
<td>The default</td>
</tr>
<tr>
<td>Length</td>
<td>100</td>
<td>Field length</td>
</tr>
<tr>
<td>Title</td>
<td>Comment</td>
<td>Alias name to substitute in messages and screen labels</td>
</tr>
<tr>
<td>Search Type</td>
<td>Wildcard</td>
<td>Wildcard lets you search on this attribute using wild card characters like * and %</td>
</tr>
</tbody>
</table>

7 Click Save.

The Status of the new attribute changes to Add.

8 Configure your database.

See "Running ConfigDB to configure the database" for detailed instructions.

**NOTE** Saving a change in Database Configuration stores the update in a cfg table. It does not implement the change in the database. You must run the ConfigDB batch file to update the database.

**Adding a New Crossover Domain**

Follow the steps below to add a crossover domain named ASSET2WO:

1 Open the Domains application by choosing Go To > Configuration > Domains.

2 Click Add New Domain > Add New CROSSOVER Domain to open the CROSSOVER Domain screen.
Displaying Information in an Application Using Crossover Domains

**CROSSOVER Domain Screen**

3. Enter ASSET2WO as the Domain name and Asset to Work Order Crossover Domain as the full description.

4. Click New Row in the CROSSOVER Domain section to open the detail section.

**CROSSOVER Domain Detail**

5. Enter ASSET in the Object field. This step defines ASSET as the source object of the crossover.


   **NOTE** See Linking the WORKORDER and ASSET objects procedure for more information on the Validation Where Clauses.

7. Click New Row in the Crossover Fields section to open the detail section.

**Crossover Fields Detail**

8. Use the lookup to select assetcomment from the ASSET object in the Source Field, then type woassetcomment in the Destination Field.
Applying the Crossover Domain

Now that you have created the ASSET2WO crossover domain, you must apply it to a field that triggers the crossover conditions. In this example, you apply the crossover to the Asset Number (ASSETNUM) field. Subsequently, whenever you enter an asset number in Work Order Tracking, Maximo executes the crossover domain and copies the value in assetcomment to woassetcomment for the new work order record.

1. Open Database Configuration by choosing Go To > Configuration > Database Configuration.

2. Type WORKORDER in the Object search field, and click Enter.

3. Click WORKORDER to open the Work Order screen in the Object tab.

4. Click the Attributes tab to open the Attributes Details screen.

5. Click Filter, and enter ASSETNUM in the Attribute field.

6. Press Enter to open the ASSETNUM details section, and enter ASSET2WO in the Domain field.

7. Click Save.

NOTE: To complete the process of adding and applying the ASSET2WO crossover, you must configure your database. Refer to "Running ConfigDB to update the database" for instructions.

Adding a Textbox for Woassetcomment in Work Order Tracking

Complete this procedure to add a textbox control in Work Order Tracking using Application Designer. The textbox displays the woassetcomment attribute value when you enter an asset number in a work order.

Before you start, verify that you have completed the following tasks:

- Added assetcomment attribute to the ASSET object and woassetcomment to the WORKORDER object
- Added textbox control for assetcomment to Assets in Application Designer (Must subsequently enter a comment for a new or existing asset, for example, "John Doe is monitoring this motor...")
- Added ASSET2WO crossover domain in Domains
- Added ASSET2WO to the WORKORDER woassetcomment attribute in Database Configuration
- Configured your database

Complete the following steps to add a textbox for woassetcomment in Work Order Tracking.
1. Open Application Designer by choosing Go To > Configuration > Application Designer.

2. Type WOTRACK in the Application search field, and press Enter.

3. Click WOTRACK to open Work Order Tracking in the Workspace tab.

4. Select the Work Order tab.

5. Click the section that holds the Asset field.

**Asset Section of Work Order Tracking in Application Designer**

6. Click the Control Palette button to open the Controls palette.

7. Drag the Textbox control on top of the Parent WO field to position the control between the Asset and Parent WO fields.

**Textbox Control Dropped into Section with Asset Number Field**

8. With the Textbox control selected, click the Control Properties button to open the Textbox Properties dialog box.
Enter the following information to bind the Textbox control to the woassetcomment attribute:

<table>
<thead>
<tr>
<th>Field</th>
<th>Input Value</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Default Label</td>
<td>Defaults to Comment</td>
<td>When you specify woassetcomment in the Attribute field, this field defaults to the attribute's default label value (if available).</td>
</tr>
<tr>
<td>Label</td>
<td>Comments</td>
<td>The value you enter here, for example, Comments, overrides the Default Label setting within the application. The value you enter for Label is specific to the application and not stored in an object.</td>
</tr>
<tr>
<td>Attribute</td>
<td>woassetcomment</td>
<td>The name of the asset comment attribute in the WORKORDER object.</td>
</tr>
<tr>
<td>Input Mode</td>
<td>READONLY</td>
<td>Configures the Input Mode for the Comments field. In this scenario, regardless of the Input Mode setting, you cannot edit the Comments value.</td>
</tr>
</tbody>
</table>

The completed Textbox Properties dialog box appears below.

**Textbox Properties Dialog Box**

10 Click Save.

In summary, by completing the crossover domain procedures you accomplished the business objective of retrieving read-only asset comment information whenever a user enters an asset number in a work order. The crossover domain enables the following actions:
How to Create Application Restrictions

You can use Application Designer to define restrictions on what records can display in an application. You can filter what data a user can see when opening an application by entering a query in the application's presentation control. You might want to filter what records a specific application displays when it and several other applications use the same data source, but not all of the data records in the set are applicable to all of the applications.

To define an application restriction, complete the following steps:

1. Open Application Designer by choosing Go To > Configuration > Application Designer.
2. Type the name of the application you wish to open, or press Enter to display a list of applications.
3. As an example, open the Assets application in the Workspace tab.
4. Click Select Action > Toggle Show All Controls.
5. Click the "presentation..." control.
6. Click the Control Properties button to open the Presentation Properties dialog box.
7. In the Where Clause field, enter "inactive='0'". Application Designer interprets the query as "select * from asset where inactive='0'".
8. Click Save.

When you open the Assets application, you will only see records where the inactive attribute has a value of "0".
How to Duplicate an Application

You can use Application Designer to duplicate an existing Maximo application. In previous releases, duplicating an application was referred to as "cloning." If you duplicate an application, you create a copy of the application's presentation and application definition.

To duplicate an existing application, complete the following steps:

1. Open Application Designer application by choosing Go To > Configuration > Application Designer.
2. Type the name of the application you wish to open, or press Enter to display a list of applications.
3. Open the application you want to duplicate in the Workspace tab.
4. Open the Duplicate Application dialog box by choosing Select Action > Duplicate Application Definition.
5. Enter a unique name for the duplicated application in the Application field and a text description in the Description field. The name you enter in the Description field is what will appear in the navigation bar of the application.
6. Click OK to open the new application in the Workspace tab.
7. Click Save.

The new application appears in the same module as the original application. To view the new application, complete the following steps:

- Sign out of Maximo (refreshes the list of applications in the "Go To" menu)
- Sign in to Maximo
- Navigate to the new application

How to Create a New Application

Application Designer lets you create three different types of new applications:

- Standard power application
- Single page
- Self service

Maximo uses a different template for each application type to create the basic user interface structure of the application.

A power application is a multi-tab application. The template used to create a power application lets you build an application with the following characteristics:
How to Create a New Application

- Multi-tabs, including the standard List and Workspace tabs
- Select action menu
- Toolbar buttons and other user interface components contained in a regular Maximo application

A single page application uses a variation of the power application’s template. There are no tabs, but regular toolbar options are available.

A self service application uses a more restrictive template with fewer user interface options. The template is designed for creating a record and not browsing data, so there is no default list table window and no ordinary toolbar.

To create a new application, complete the following steps:

1. Open Application Designer by choosing Go To > Configuration > Application Designer.
2. Click New Application Definition in the toolbar to open the Create a New Application dialog box.
3. Enter a unique name for the new application in the Application field.
4. Enter a brief description of the new application in the Description field. This name becomes the title of the application in the Maximo navigation bar and in the Go To menu.
5. Enter the name of the main object (primary database table) for the application in the Main Object field.
6. Note that the main object you enter here should already exist in the Maximo database. Use Database Configuration to define new objects.
7. Enter the name of the Maximo module for this application. If needed, click the select value icon to display a list of modules.
8. Click the button for the type of application you want to create:
   - Power App
   - Single Page App
   - Self Service App

   The new application opens in the Workspace tab.
9. Click Save Application Definition to save your new application to the database.

Maximo sets the default security to Read. All users who have access to the application in their security profile can read records but not insert or delete. You can define additional signature options for a new application using the Add/Modify Signature Options select action. Refer to Appendix A for a complete list of signature options.
You can use the Controls and the Properties floating dialog boxes to add or modify controls (such as tabs, buttons, and table windows) in the new application.

To view your new application in the Maximo “Go To” menu, sign out and then back into Maximo.

**How to Lay Out a New Tab**

When you create a new application or add a new tab to an existing application, Application Designer displays an empty screen. This is the starting point to begin laying out the structure and location for all the elements that will make up this new screen.

To begin the layout of a new screen, add a section control. This control designates a space where you can add additional controls. You can break the layout of the page vertically by adding additional section controls.

You can break a section into horizontal segments or columns by adding section column controls to the section control. A section by default can not render itself and only acts a container for other controls. You can make a section display a bar and a minimize/maximize button by completing the Section Properties dialog box.

Once you create the basic layout of a screen with the section controls, you can begin adding additional controls that display data such as the textbox control.

**How to Delete a User-Created Application**

You must use a database editor (for example, SQL Plus) to delete an application that you created in Application Designer.

**NOTE**
Deleting an application does not remove any custom tables, fields, or domains that you might have created to support the application. Additionally, you must shut down the Maximo application server before you delete an application created with Application Designer.

To delete an application that you created or duplicated, open a database editor and complete the following steps:

1. Login as an administrator.

2. Type the following commands, and replace the variable `<APPLICATION NAME>` with the name of the application you want to delete.

   Enter the application name in uppercase. For example, if the name of the application you want to delete is Test, replace `<APPLICATION NAME>` with `<TEST>` in all the commands.

   ```
   delete from maxapps where app='<APPLICATION NAME>';
   delete from maxpresentation where app='<APPLICATION NAME>';
   delete from sigoption where app='<APPLICATION NAME>';
   ```
How to Control the Size of Fields

Maximo restricts how much of a field appears in the user interface so that fields of varying lengths do not show jagged edges when stacked on top of each other.

The settings are kept in this file:

```
<maximo_root>\applications\maximo\maximouiweb\webmodule\webclient\common\fieldsizegroups.jsp
```

For string fields (ALN, UPPER, LOWER), the defined sizes are:

- ▼ If the database size is 1 or 2 characters, then the field length displayed on a screen is 2.
- ▼ If the database size is 3 through 30 characters, then the field length displayed on a screen is 10.
- ▼ If the database size is greater than 30 characters, then the field length displayed on a screen is 40.

**NOTE** There is no specific unit of measure for field lengths displayed on screens.

The code for ALN, LOWER, UPPER field types appears below:

```java
fieldtypegroup = new Hashtable();
fieldtypegroup.put(new Integer("2"), new Integer("2"));
fieldtypegroup.put(new Integer("30"), new Integer("10"));
fieldtypegroup.put(new Integer("31"), new Integer("40"));
fieldsizegroups.put(new Integer(FIELD_TYPE_ALN).toString(), fieldtypegroup);
fieldsizegroups.put(new Integer(FIELD_TYPE_LOWER).toString(), fieldtypegroup);
fieldsizegroups.put(new Integer(FIELD_TYPE_UPPER).toString(), fieldtypegroup);
```

**NOTE** If you make any changes to the fieldsizegroups.jsp file, you must rebuild the maximo.ear file.
How to Optimize the Placement of Input Fields for Data Entry

When you design the user interface for a predominantly data entry application, it is crucial to order input fields to optimize the use of the Tab key to navigate between fields. Tabbing order goes from top to bottom and from left to right. You can delete fields not needed for data entry on an input screen, or move those fields to another screen.

If you wish to change the position for a large number of data input fields in an application, consider duplicating an existing application and then changing the order of the input fields.

How to Add Buttons and Select Action Menu Items

You can add new toolbar buttons and select action menu items to an application by choosing one of the following select actions in Application Designer:

- Add/Modify Toolbar Menu
- Add/Modify Select Action Menu

When adding a new button, the name you enter in the Key Value field will display in the toolbar when you mouse over the icon that represents the action associated with the button, such as Insert or Delete. Additionally, you can specify the following:

- The name of the image file that will represent the button in the toolbar
- The position of the button in the toolbar
- Which tabs will display the new toolbar button

The steps to add a new select action menu item are very similar to adding a new button, and both share the same dialog box for entering attributes.

How to Define Signature Options for an Application

Application Designer enables you to add or modify signature options for a new or existing application. Signature options, which are listed in Appendix A, specify privileges for using Maximo applications, menu options, and toolbar items.

To define signature options, complete the following steps:

1. Open Application Designer by choosing Go To > Configuration > Application Designer.
2. Open an application in the Workspace tab.
How to Assign and Override the Default Label Value for a Textbox Control

All controls that have a text field component, such asTextbox or MultilineTextbox, have two label fields: Default Label and Label. Both of these fields, which appear in the Control Properties dialog box, are blank when you first drag a textbox control into an application. The field name that displays in the user interface is the name for the control. For example, if you drag a MultilineTextbox into an application, its name becomes "multilinetextbox...".

A textbox control acquires a Default Label when you link the control to an object attribute. This Default Label displays in the user interface and is read only. However, you can override the Default Label value for a control by entering a different value in the Label field. The value in the Label field overrides the Default Label name inherited from the object attribute. This feature enables textbox controls linked to the same object attribute to have different labels in different applications. Maximo stores the label values for textbox fields in the MAXLABELS table.

Assigning a Value to a Default Label Field

Complete the following steps to assign a value to the Default Label for a textbox control.

1 Open Application Designer by choosing Go To > Configuration > Application Designer.

2 Open an application in the Workspace tab, for example, the Assets application.
How to Define Default Values for Fields

3 Click the Asset tab, and select a section control.

4 Click the Control Palette button to open the Controls dialog box.

5 Drag the Textbox control into the highlighted section.

6 Select the Textbox control, and click the Control Properties button.

7 In the Textbox Properties dialog box, click the lookup icon for the Attribute field, and select ORGID.

Notice that the field label in the workspace and the Default Label field in the dialog box change to Organization, which is the value in the Title field for the ORGID attribute.

NOTE You define the value of the Title field in the Database Configuration application. All textbox controls that bind to the ORGID attribute, for example, inherit the value of Organization in the Default Label field.

8 Click Save.

Overriding a Value in the Default Label Field

Complete the following steps to override the Default Label value for a textbox control.

1 Open Application Designer by choosing Go To > Configuration > Application Designer.

2 Open an application in the Workspace tab, for example, the Assets application.

3 Click the Asset tab, and select a textbox control.

4 Select the Textbox control, and click the Control Properties button.

5 In the Textbox Properties dialog box, enter a new name for the textbox control in the Label field. If the Default Label has a value of Organization, for example, you may want to enter a different, but similar value in the Label field, such as Org ID.

Notice that the field label in the workspace for the textbox control changes to "Org ID."

6 Click Save.

How to Define Default Values for Fields

You can specify a default value for a field by entering that value in the Default Value field of the attribute to which the field is bound. You specify a default value in the Details section for the attribute in the Database Configuration application. For example, if you want the GLACCOUNT attribute in the WORKORDER table to default to a specific account number, then you would
enter that number in the Default Value field. The GL Account Number you entered will appear as the default value in all fields that are bound to the GLACCOUNT attribute.

Alternatively, you can define a field default value that is local to an application by using the Default Value control by completing the following steps:

1. Open Application Designer by choosing Go To > Configuration > Application Designer.

2. Open an application in the Workspace tab.

3. Open the Control Palette.

4. Drag the Default Value control into the section that contains the field for which you want to assign a default value. If you do not see the Default Value control in the Section, click Select Action > Toggle Show All Controls.

5. Open the properties dialog box for the control, and enter the following:
   - The name of the attribute bound to the field to which you are assigning the default value
   - Enter the desired default value in the Value field
   - Select "Insert" for Default Type

6. Click Save.

How to Define a Default Filter for a Table

You can use Application Designer to define a default query for a table window using the Default Value control. When you first open the table, Maximo uses the query value or values you define, to filter the records displayed from a table. For example, if you query the attribute ITEM_DESCRIPTION and specify a value of MOTOR, then the table will only display item records that have MOTOR somewhere in the description. You can also use % as a wildcard and = for exact match. If you set the value to =MOTOR, Maximo displays item records with only MOTOR in the item description.

Complete the following steps:

1. Open Application Designer by choosing Go To > Configuration > Application Designer.

2. Open an application in the Workspace tab.

3. Drag the Default Value control into the section that contains the table for which you want to define a default filter. If you do not see the Default Value control in the Section, click Select Action > Toggle Show All Controls.
4 Open the properties sheet for the control, and enter the following:

- The name of the attribute of the column to which you are assigning the default query
- Enter the desired value in the Value field (Use a comma as a delimiter if you filter based on multiple values)
- Select "Query" for Default Type

5 Click Save.

How to Modify Application Dialogs

You can use Application Designer to edit application-specific dialog boxes that Maximo stores within the XML presentation of the application.

Complete the following steps:

1 Open Application Designer by choosing Go To > Configuration > Application Designer.

2 Open an application in the Workspace tab.

3 Click the Edit Dialogs button to open a list of dialog boxes specific to the application.

4 You can edit the dialog content in the same way that you would edit any other user interface element in the workspace.

5 The Maximo user interface also provides general purpose dialogs that are used by more than one application. To edit these dialogs, such as Change Status, you must use a text editor to update the library.xml file located in the following directory:

<maximo_root>/resources/presentation/system

6 If you edit library.xml or any other presentation type XML file, you must import the updated file into the database by using the Import Application Definition button in Application Designer. The import functionality is available in both the Applications and Workspace tabs.

How to Move Controls Across Tabs

Use the Copy or Cut and Paste buttons to move a control or a section grouping of controls from one tab to another within the same application. Select the individual control or a section control that contains other controls, and click on Copy or Cut. Click the desired tab, and then select the target control (usually a section). Click the Paste button in the toolbar.
How to Move Controls Across Applications

You can move an individual control or a section container of controls across applications by editing the XML presentation code and using the import/export buttons of Application Designer.

Complete the following steps:

1. Open Application Designer by choosing Go To > Configuration > Application Designer.
2. Open the source application in the Workspace tab.
3. Click the Export Application Definition button.
4. Choose File > Save As to save the XML definition to a file.
5. Open the destination application in the Workspace tab.
6. Repeat Steps 3 and 4.
7. Open the saved source and destination XML files in a text editor, such as WordPad.
8. In the XML of the source file, navigate to the section ID or the individual control ID that you want to copy. Select and copy the line(s) of code.
   Use the unique ID of a control in the property sheet of Application Designer to simplify searching in XML presentation files.
9. Open the destination file, and search for the location where you want to copy the code from the source file. For example, choose Ctrl+V or choose Edit > Paste in a Windows environment.
10. Save both XML files.
11. In Application Designer, open the destination application in the Workspace tab.
12. Click the Import Application Definition button, and enter the destination XML file name with your edit.
13. Click OK.

To view your change, click the Tab in the destination application that contains the XML code.

**NOTE**
When you copy a control like a Multipart Textbox to a different Maximo application, the control must link to an attribute that exists in the main object table for both applications to view data from the database. If the attribute relationship does not exist, the Multipart Textbox control copied to the source destination application does not contain any property values.
How to Move User Interface Configurations Across Servers

You can move your user interface configurations to other servers using the export and import functionality of Application Designer. These features enable you to easily move Maximo applications between multiple environments, for example testing and production, while different people in your organization configure individual applications.

If you or someone in your organization wants to update the user interface configuration for an application, it is good practice first to export the existing user interface XML file(s) to a backup directory. If you want to restore this instance of the user interface in the future, use the Import Application Definition feature. When you import an application, you are overwriting the application in your database and not in the presentations directory.

You can locate presentation XML files in the `<maximo_root>\resources\presentations` directory. These files are for illustration and reference. Do not modify them. However, you can copy one of these files, save it with a new name, and then make modifications. You can then import the modified file into Maximo using Application Designer.

How to Export Multiple Applications

You can copy multiple applications at the same time to another server by exporting the XML presentations to a single file.

Complete the following steps:

1. Open Application Designer by choosing Go To > Configuration > Application Designer.
2. In the Applications tab, click Select Records.
3. Check each application whose XML presentation you want to export.
4. Click the Export Application Definition button.
5. A new browser window opens a single XML file with the presentation code for each application you exported.

   Note that the Import Application Definition function reads the beginning and an end point for each application embedded in the XML file and loads the code appropriately. You can find the start point for an application by searching for the "presentation id" text string.

6. Choose File > Save As to save the XML file to a directory.
How to Link to an External URL

You can create a link to an external Web site from a Maximo application using the HyperLink control. Drop the HyperLink control into a section or table container, and then enter a valid URL for the destination site in the URL field of the control's property sheet.

When you click on the URL link within the application, Maximo opens the destination site in a new browser window.

How to Link to an Application from a Text Field

Many text fields in Maximo applications already contain GOTO links to other applications, but you can create your own link by defining the GOTO Application and Menu Type fields of certain controls, such as Multipart Textbox, Textbox, and Table Column.

Complete the following steps:

1. Open Application Designer by choosing Go To > Configuration > Application Designer.

2. Open an application in the Workspace tab.

3. Select a textbox control, and click the Control Properties button.

4. Enter values in the GOTO Application and Menu Type fields.

You can locate the Menu Type ID values in menus.xml, which is located in <maximo_root>/resources/presentations/system.

For example, if you select the Asset field in Work Order Tracking, the properties dialog box has a value of "ASSET" in the GOTO Application field and a value of "ASSETMAIN" in the Menu Type field.

How to Modify Contents of the Go To Menu

Application Designer does not currently allow you to customize the Go To menu for an application. However, when creating a new application, Application Designer lets you specify in which module you would like the new application to appear. When duplicating applications, the newly created application will be available in the same module as the originating application.
List of Signature Options

This section lists the signature options available to new and existing applications. See How to Define Signature Options for an Application for more information.

Common Signature Options

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>STATUS</td>
<td>Change Status</td>
<td></td>
</tr>
<tr>
<td>INSERT</td>
<td>New</td>
<td></td>
</tr>
<tr>
<td>SAVE</td>
<td>Save</td>
<td></td>
</tr>
<tr>
<td>CLOSE</td>
<td>Close</td>
<td></td>
</tr>
<tr>
<td>CANCEL</td>
<td>Cancel</td>
<td></td>
</tr>
<tr>
<td>CLEAR</td>
<td>Clear Changes</td>
<td></td>
</tr>
<tr>
<td>PREVIOUS</td>
<td>Previous</td>
<td></td>
</tr>
<tr>
<td>NEXT</td>
<td>Next</td>
<td></td>
</tr>
<tr>
<td>ASSOCFOLD</td>
<td>Associate Folders</td>
<td></td>
</tr>
<tr>
<td>MANAGEFOLD</td>
<td>Manage Folders</td>
<td></td>
</tr>
<tr>
<td>MANAGELIB</td>
<td>Manage Library</td>
<td></td>
</tr>
<tr>
<td>DUPLICATE</td>
<td>Duplicate Work Order</td>
<td></td>
</tr>
<tr>
<td>DELETE</td>
<td>Delete</td>
<td></td>
</tr>
<tr>
<td>BOOKMARK</td>
<td>Add to Bookmarks</td>
<td></td>
</tr>
<tr>
<td>RUNREPORTS</td>
<td>Run Reports</td>
<td></td>
</tr>
<tr>
<td>SEARCHBOOK</td>
<td>Bookmarks</td>
<td></td>
</tr>
<tr>
<td>SEARCHMORE</td>
<td>More Search Fields</td>
<td></td>
</tr>
<tr>
<td>SEARCHSQRY</td>
<td>Save Current Query</td>
<td></td>
</tr>
<tr>
<td>SEARCHTIPS</td>
<td>View Search Tips</td>
<td></td>
</tr>
</tbody>
</table>
## Common Signature Options

<table>
<thead>
<tr>
<th>Control Name</th>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>SEARCHVMQR</td>
<td>View/Manage Queries</td>
<td></td>
</tr>
<tr>
<td>SEARCHWHER</td>
<td>Where Clause</td>
<td></td>
</tr>
<tr>
<td>ACTIVATE</td>
<td>Activate</td>
<td>Activate Process</td>
</tr>
<tr>
<td>ADDMOD</td>
<td>Add/Modify</td>
<td>ADDMODACTN — Add/Modify Actions</td>
</tr>
<tr>
<td>APPLYIAS</td>
<td>Apply Item Assembly Structure</td>
<td></td>
</tr>
<tr>
<td>APPLYPRAD</td>
<td>Apply Price Adjustment</td>
<td></td>
</tr>
<tr>
<td>APPLYRTE</td>
<td>Apply Route</td>
<td></td>
</tr>
<tr>
<td>APPLYSLA</td>
<td>Apply SLAs</td>
<td></td>
</tr>
<tr>
<td>APPR/APPROVE</td>
<td>Approve</td>
<td></td>
</tr>
<tr>
<td>ASGNEWPRNT</td>
<td>Assign to New Parent</td>
<td></td>
</tr>
<tr>
<td>ASSIGNWF</td>
<td>View Workflow Assignments</td>
<td></td>
</tr>
<tr>
<td>ASSOCCOMM</td>
<td>Associate Commodities</td>
<td></td>
</tr>
<tr>
<td>ASSOCSLA</td>
<td>Associate Slays</td>
<td></td>
</tr>
<tr>
<td>ASTLOCCOMM</td>
<td>Associate Services</td>
<td></td>
</tr>
<tr>
<td>AUTHSITES</td>
<td>Authorize Sites</td>
<td></td>
</tr>
<tr>
<td>COMMCODE</td>
<td>Add/Modify Commodity Codes</td>
<td></td>
</tr>
<tr>
<td>COMP</td>
<td>Complete</td>
<td>Complete Work Order</td>
</tr>
<tr>
<td>CONVERSION</td>
<td>Add/Modify Conversions</td>
<td>CREATEWO — Create Work Order</td>
</tr>
<tr>
<td>CREATE</td>
<td>Create</td>
<td></td>
</tr>
<tr>
<td>CURBALADJ</td>
<td>Current Balance</td>
<td></td>
</tr>
<tr>
<td>DRAFT</td>
<td>Change Status to Draft</td>
<td></td>
</tr>
<tr>
<td>DRILLDOWN</td>
<td>Open Drilldown</td>
<td></td>
</tr>
<tr>
<td>EDITHIST</td>
<td>Edit History</td>
<td>Edit History Work Order</td>
</tr>
<tr>
<td>EXPIRE</td>
<td>Change Status to Expire</td>
<td></td>
</tr>
<tr>
<td>FIELDDEFS</td>
<td>Set Field Defaults</td>
<td></td>
</tr>
<tr>
<td>GENERATEWO</td>
<td>Generate Work Orders</td>
<td></td>
</tr>
<tr>
<td>HELPWF</td>
<td>Workflow Help</td>
<td></td>
</tr>
<tr>
<td>HISTORYWF</td>
<td>View Workflow History</td>
<td></td>
</tr>
<tr>
<td>INACTIVATE</td>
<td>Inactivate</td>
<td>Inactivate a person</td>
</tr>
<tr>
<td>INPRG</td>
<td>Change Status to in Progress</td>
<td></td>
</tr>
<tr>
<td>INVTRANS</td>
<td>View Inventory Transactions</td>
<td></td>
</tr>
<tr>
<td>MASSMOVE</td>
<td>Move/Modify Assets</td>
<td></td>
</tr>
<tr>
<td>Control Name</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------</td>
<td>----------------------------------------------</td>
</tr>
<tr>
<td>MEASUNIT</td>
<td>Add/Modify Units of Measure</td>
<td></td>
</tr>
<tr>
<td>METERREAD</td>
<td>Enter Meter Readings</td>
<td></td>
</tr>
<tr>
<td>METHIST</td>
<td>Manage Meter Reading History</td>
<td></td>
</tr>
<tr>
<td>METHISTUPD</td>
<td>Update Meter History</td>
<td></td>
</tr>
<tr>
<td>METREADNEW</td>
<td>Enter Most Recent Meter Reading</td>
<td></td>
</tr>
<tr>
<td>METREADOLD</td>
<td>Enter Meter History</td>
<td></td>
</tr>
<tr>
<td>METRESET</td>
<td>Reset/Replace Meters</td>
<td></td>
</tr>
<tr>
<td>MODDELWL</td>
<td>Modify/Delete Work Log</td>
<td></td>
</tr>
<tr>
<td>MODIFYSLAS</td>
<td>Select/Deselect SLAs</td>
<td></td>
</tr>
<tr>
<td>MOVEASSET</td>
<td>Move/Modify Assets</td>
<td></td>
</tr>
<tr>
<td>MOVEVAR</td>
<td>Move Variants</td>
<td></td>
</tr>
<tr>
<td>NEWWRKPKG</td>
<td>Create Work Package</td>
<td></td>
</tr>
<tr>
<td>NOPORTLET</td>
<td>Hide Portlet</td>
<td></td>
</tr>
<tr>
<td>OWNER</td>
<td>Select Owner</td>
<td></td>
</tr>
<tr>
<td>OWNERSHIP</td>
<td>Take Ownership</td>
<td></td>
</tr>
<tr>
<td>PNDREV</td>
<td>Change Status to Pending Revision</td>
<td></td>
</tr>
<tr>
<td>QUEUED</td>
<td>Problem in queue</td>
<td></td>
</tr>
<tr>
<td>READ</td>
<td>Read access</td>
<td>Read access to Work Order Tracking</td>
</tr>
<tr>
<td>RECONCILE</td>
<td>Reconcile Balances</td>
<td></td>
</tr>
<tr>
<td>REMOVEWP</td>
<td>Remove Work Plan</td>
<td></td>
</tr>
<tr>
<td>REORDER</td>
<td>Reorder Items</td>
<td></td>
</tr>
<tr>
<td>REORISS</td>
<td>Reorder Direct Issue Itms/Svcs</td>
<td></td>
</tr>
<tr>
<td>RESOLVED</td>
<td>Resolve problem</td>
<td></td>
</tr>
<tr>
<td>REVCONT</td>
<td>Revise Contract</td>
<td></td>
</tr>
<tr>
<td>REVHIST</td>
<td>View Revision History</td>
<td></td>
</tr>
<tr>
<td>ROUTEWF</td>
<td>Route Workflow</td>
<td></td>
</tr>
<tr>
<td>SELASPARTS</td>
<td>Select Asset Spare Parts</td>
<td></td>
</tr>
<tr>
<td>SHOWPLAN</td>
<td>Entire Plan</td>
<td></td>
</tr>
<tr>
<td>SIMILARTKT</td>
<td>Show Similar Tickets</td>
<td></td>
</tr>
<tr>
<td>STARTTIMER</td>
<td>Start Timer</td>
<td></td>
</tr>
<tr>
<td>STOPTIMER</td>
<td>Stop Timer</td>
<td></td>
</tr>
<tr>
<td>STOPWF</td>
<td>Stop Workflow</td>
<td></td>
</tr>
<tr>
<td>Control Name</td>
<td>Description</td>
<td>Example</td>
</tr>
<tr>
<td>-------------------------</td>
<td>------------------------------------</td>
<td>--------------------------------------</td>
</tr>
<tr>
<td>SUSPND</td>
<td>Change Status to Suspend</td>
<td></td>
</tr>
<tr>
<td>TEMPLATE</td>
<td>Apply Template</td>
<td>Apply Problem Template</td>
</tr>
<tr>
<td>TRANSFER</td>
<td>Transfer Current</td>
<td>Transfer Current Item</td>
</tr>
<tr>
<td>UNAPPROVE/UNDOAPPR</td>
<td>Unapprove/Undo Approval</td>
<td>Undo Approval of Work Order</td>
</tr>
<tr>
<td>USERCUST</td>
<td>Associate Users and Custodians</td>
<td></td>
</tr>
<tr>
<td>VALIDATE</td>
<td>Validate</td>
<td>Validate Process</td>
</tr>
<tr>
<td>VIEWCONT</td>
<td>View Contracts</td>
<td></td>
</tr>
<tr>
<td>VIEWCOSTS</td>
<td>View Costs</td>
<td></td>
</tr>
<tr>
<td>VIEWHIST</td>
<td>View History</td>
<td></td>
</tr>
<tr>
<td>WMATL</td>
<td>Set status to Waiting for Material</td>
<td>Set Work Order status to Waiting for Material</td>
</tr>
<tr>
<td>WO_SLAS</td>
<td>View SLAs</td>
<td></td>
</tr>
<tr>
<td>WSTART</td>
<td>Change Status to Waiting to Start</td>
<td></td>
</tr>
<tr>
<td>ZEROYTD</td>
<td>Zero Year to Date Quantities</td>
<td></td>
</tr>
</tbody>
</table>
This appendix lists the controls available in the control palette of Application Designer. Each control contains an introduction, rules, example, and properties description section. The controls appear in alphabetical order.

### Appbar

The Appbar, short for application bar, is a menu bar that is always open at the top of a page. The Appbar automatically lists all applications in a Maximo module except the currently active application. An application bar appears in Maximo self service applications like Desktop Requisitions and Service Requests that do not use tabs.

### Rules

This is not a container control.

You can place this control inside the following container control:

- ▼ Client area

### Example

1. Appbar Properties dialog box configured in Application Designer.
Attachments

2 Appbar as it appears in Application Designer workspace.

3 Appbar as it appears in the Create Service Request application.

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The name you assign to the Appbar control. This value does not display in the user interface.</td>
</tr>
</tbody>
</table>

Attachments

You can activate the drop down menus and dialog boxes associated with Attachments by dropping the control into any Section container in a Maximo or custom application. However, you cannot access the functions used to build the Attachments control through the interface of Application Designer.

The Attachments control lets you change the label for Attachments that appear in various Maximo applications. For example, you can view Attachments in Assets > Asset. A paper clip icon appears next to the Attachments label.

Rules

This is not a container control.

You can place this control inside the following container control:
Example

1. Attachments Properties dialog box configured in Application Designer.

![Attachments Properties dialog box](image)

2. Attachments control as it appears in the workspace of Application Designer.

![Attachments control in workspace](image)

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The name you assign to the Attachments control. The label value identifies the control to the user. If you do not enter a label, the title defaults to &quot;attachments&quot; in the user interface. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
</tbody>
</table>

Blank Line

A Blank Line inserts vertical white space in a section. You might, for example, use this control to add white space between text boxes or rows in a table. Blank lines provide spacing between controls to improve readability or to visually separate different types of controls within a section.

A Blank Line does not have configurable properties and simply functions as a graphical element without intelligence. A Blank Line does not have a label. Blank lines, like Sections Columns and Section Rows, are transparent in the Maximo user interface.
Button Group

Rules

This is not a container control.

You can place this control inside the following container control:

- Section

Example

![Example Image]

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
</tbody>
</table>

Button Group

A Button Group is a container control that holds pushbuttons. The Button Group defines the layout for the buttons it holds, including alignment within the container and the title for the group.

Rules

You can place the following control in this container control:

- Pushbutton

You can place this control inside the following container control:

- Section
- Table
Example

1  Button Group Properties dialog box configured in Application Designer.

2  Button group as it appears in workspace of Application Designer.

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The name you assign to the Button Group control. The label value identifies the control to the user. If you do not enter a label, the Button Group title is transparent in the user interface. Most Button Groups do not have a label in Maximo, because the control functions primarily as a container that holds a layout for its children pushbuttons. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Text Alignment</td>
<td>Select an alignment value to position the Button Group label within the control. The options are Left, Center, or Right. The text label always displays to the left of any pushbuttons you add to the group.</td>
</tr>
<tr>
<td>Button Alignment</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
Checkbox

A Checkbox is an input type of control that typically enables a user to select one or more items from a list or to indicate a yes/no response to a question. A selected box, for example, indicates a Yes response to a question. Also, a Checkbox can display information that is inherited from the database, which you may be able to edit depending on the Input Mode property setting.

Checkbox is similar to a text type of control, such as Textbox and Multiline Textbox, because it has a text field component or label that is visible in the user interface. The dialog boxes for these types of controls usually have a Default Label property that enables the control to inherit a read-only label from the attribute you configure for the control. The Default Label value comes from the database object. Alternatively, you can override an inherited Default Label by entering a different value in the Label property. This value is local to the application’s presentation file. Labels you enter at the presentation level are not stored in the MAXATTRIBUTE or MAXLABELS table.

Checkboxes appear in most applications and, depending on property settings, can accept user input or display information from the database.

Rules

This is not a container control.

You can place this control inside the following container control:

- Section

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show Container?</td>
<td>Select this property to display a shaded background of horizontal lines for a Button Group container. Note that you cannot view background shading for a Button Group control in a Table container.</td>
</tr>
</tbody>
</table>
Example

1  Checkbox control dropped into section without defined properties.

2  Checkbox Properties dialog box.

3  Checkbox with defined properties.

NOTE  The label for the Checkbox control displays in the application with a question mark as "GL Account?"

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Null (aka Default Label)</td>
<td>This label defaults to the text value associated with the database attribute you bound to the Checkbox. This is a read only field.</td>
</tr>
</tbody>
</table>
Checkbox

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>You can enter a text value in this field that overrides the Default Label value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
</tbody>
</table>

Attribute You can associate a Checkbox with a database attribute by using the Select Value dialog box. To create the example for this control, you can enter "=asset" in the Object field to display all the attributes in the ASSET table.

Select the "GLACCOUNT" attribute to inherit the "GL Account?" label for the Checkbox. Not all attributes you select will have a database default label value.

Value Reserved for future use.

Input Mode Select one of the options listed below for the Input Mode:

- Default
- Password
- Password Readonly
- Password Required
- Query
- Readonly
- Required
The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

Input Mode Option Descriptions:

**Default** – sets control to "edit" so you can display or input values and mode is read/write

**Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write

**Password Readonly** – sets control to display asterisks and mode is read only

**Password Required** – sets control to display asterisks and the control is required

**Query** – sets control to display a typed value and mode is read only

**Readonly** – sets control to display grayed-out text and mode is read only

**Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control

Data Change Event

You can configure an input control to perform either of the following actions based on any data change to the control:

▼ REFRESHTABLE
▼ RESETCHILDREN

Choosing REFRESHTABLE forces the table that is the data source for the input control to refresh its data. Choosing RESETCHILDREN forces any children of the control’s data bean to delete and reacquire their MBOSetRemote references.

Data Source ID

If you want this control to use a different Data Source ID than the default of MAINRECORD, then enter that value here.

See the Data Source ID description for the Combobox control for additional information on data sources.
A Combobox is an input and text type of control that enables a user to select one or more items from a drop-down list. Like the Checkbox and Textbox controls, the Combobox also has a text field component or label that is visible in the user interface.

The dialog boxes for these types of controls usually have a Default Label property that enables the control to inherit a read-only label from the attribute you configure for the control. The Default Label value comes from the database object. Alternatively, you can override an inherited Default Label by entering a different value in the Label property. This value is local to the application’s presentation file. Labels you enter at the presentation level are not stored in the MAXATTRIBUTE or MAXLABELS table.

Comboboxes appear less frequently than Checkboxes but are still widespread throughout most Maximo applications. Depending on property settings, Comboboxes typically let you make a single selection from a drop-down list of values displayed from the database.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- ▼ Section

**Example**

1. Combobox control in Details section of the Materials subtab in Work Order Tracking > Plans. The control label is Line Type. The application is Application Designer.
2 The Line Type Combobox Properties dialog box in Application Designer.

![Combobox Properties](image)

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label defaults to the text value associated with the database attribute you bound to the Combobox. This is a read only field.</td>
</tr>
<tr>
<td>Label</td>
<td>You can enter a text value in this field that overrides the Default Label value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
</tbody>
</table>
**Combobox**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Width</td>
<td>The Width field enables you to enter a numeric value to increase or decrease the default size of the Combobox in the user interface. For example, a Combobox has an approximate width of 120 pixels. To enlarge the width of the box, you must enter a value greater than 120 in the Width field.</td>
</tr>
<tr>
<td>Select Attribute</td>
<td>The values displayed in this field (if available) are bound to the data source and attribute you select for the control. A Select Attribute value displays in the textbox portion for the Combobox and is a synonym or abbreviation of the Display Attribute. For example, if you create a Combobox called Status, you might default or define values like WAPPR for Waiting for Approval and APPR for Approved.</td>
</tr>
<tr>
<td>Display Attribute</td>
<td>The values displayed in this field (if available) are bound to the data source and attribute you select for the control. Display Attribute values display in the pull-down menu for the Combobox. For example, if you create a Combobox called Status, you might default or define values like Waiting for Approval and Approved.</td>
</tr>
<tr>
<td>Attribute</td>
<td>You can associate a Combobox with a database attribute by using the Select Value dialog box. To create the example for this control, you can enter &quot;+=wpmaterial&quot; in the Object field to display all the attributes in the WPMATERIAL table. Select &quot;LINETYPE&quot; to inherit the &quot;Line Type&quot; label for the Combobox. Not all attributes you select will have a database default label value.</td>
</tr>
</tbody>
</table>
Input Mode Select one of the options listed below for the Input Mode:

- Default
- Password
- Password Readonly
- Password Required
- Query
- Readonly
- Required

The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

Input Mode Option Descriptions:

Default – sets control to "edit" so you can display or input values and mode is read/write

Password – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write

Password Readonly – sets control to display asterisks and mode is read only

Password Required – sets control to display asterisks and the control is required

Query – sets control to display a typed value and mode is read only

Readonly – sets control to display grayed-out text and mode is read only

Required – sets control to display a typed value and record cannot be saved unless there is a value in the control
A Data Source is a miscellaneous type of control that is mostly used in Maximo dialogs. Unlike most controls, it is transparent and does not render anything visible in the user interface like a Textbox or a Table. A Data Source control functions as a hook to a business object that other controls can reference and use as its source for table data. If you reference an inserted Data Source control, it enables you to override the default data source for the presentation or the current Parent Data Source. The example for this control shows how the Belongs To field in the Apply Item Assembly Structure uses the "parentitem" Data Source ID to identify a parent asset number.

### Rules

This is not a container control.

You can place this control inside the following container controls:

- ✔️ Section
- ✔️ Tab
- ✔️ Table
- ✔️ Client area

### Data Source

You can configure an input control to perform either of the following actions based on any data change to the control:

- ✔️ REFRESHTABLE
- ✔️ RESETCHILDREN

Choosing REFRESHTABLE forces the table that is the data source for the input control to refresh its data. Choosing RESETCHILDREN forces any children of the control's data bean to delete and reacquire their MBOSetRemote references.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Change Event</td>
<td>You can configure an input control to perform either of the following actions based on any data change to the control:</td>
</tr>
<tr>
<td></td>
<td>▼ REFRESHTABLE ▼ RESETCHILDREN</td>
</tr>
<tr>
<td></td>
<td>Choosing REFRESHTABLE forces the table that is the data source for the input control to refresh its data. Choosing RESETCHILDREN forces any</td>
</tr>
<tr>
<td></td>
<td>children of the control's data bean to delete and reacquire their MBOSetRemote references.</td>
</tr>
</tbody>
</table>
Example

1 Data Source control as it appears in Application Designer > Asset > Apply Item Assembly Structure dialog.

![Data Source control](image)

2 Data Source Properties configured in Application Designer for the Apply Item Assembly Structure dialog.

![Data Source Properties](image)

3 Parent relationship defined in Database Configuration for Asset.

![Parent relationship](image)
Data Source

4 Belongs To field in Application Designer > Apply Item Assembly Structure dialog configured to use "parentitem" defined in Step 2 to identify a parent asset number.

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Bean Class</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
### Attribute Name | Description
--- | ---
Business Object | The main MBO reference for the application. For example, Work Order Tracking uses WOTRACK and Assets uses ASSET. Every Maximo application works with a MBO and MBOSet. The set of work orders displayed on the List tab in the Work Order Tracking application, for example, is a MBOSet. Each individual work order is a MBO. An application’s presentation tag defines the main MBO for the application. MBOs are responsible for the following types of functions:

- Field validation
- Updating the database
- Business processing logic.

By default, the presentation tag for an application defines the main MBO to use when saving or displaying data through the user interface. All controls in the application share the same MBO reference via the Parent Data Source ID property. Unless overridden, all controls added to an application bind to the Parent Data Source ID. If you wish an individual control to display and process information from a different MBO, you can enter a different Parent Data Source ID.

Parent Data Source ID | If you wish this control to inherit data from a source other than MAINRECORD, enter that value in this field. You might, for example, want to define a new parent data source in an application like Work Order Tracking where a table needs to pull data from an object other than WORKORDER. The Parent Data Source ID lets you build relationships with a different data source using Where Clauses.

Relationship | You enter a relationship value in this field. You can search for values in the Database Configuration > Relationships tab. If you enter a relationship, it is automatically inherited by any controls that point to this data source.

Relationships enable a control to display information from different Maximo business objects. For example, if you entered SPAREPART, the table will be able to display information based on the defined relationship. When you enter a relationship in the Table control, it automatically prefixes any child column attributes added to the table. So, for SPAREPART, you only have to enter the column attribute name and not the full relationship of SPAREPART <attribute>.
Default Value

A Default Value is a miscellaneous type of control that lets you define the insert or query default value for any control. Unlike most controls, it is transparent and does not render anything visible in the user interface like a Textbox or a Table. The following XML from the Inventory presentation shows a query type defaultvalue ID of "rotateasset_rotasset_default" in Inventory > Inventory > Rotating Assets. Maximo configures this control to pull all the rotating asset records from the Asset table for the storeroom location you specify in the query search.

See the Example section for illustrations of how Maximo configures the Default Value Properties dialog box for this control and how the Associated Assets search table appears in Application Designer.

```
<table id="rotateasset_rotasset" relationship="ASSET"
label="Associated Assets">
  
  <defaultvalue id="rotateasset_rotasset_default"
dataattribute="location" fromdatasrc="MAINRECORD"
fromattribute="location" defaulttype="query" />

  - <tablebody id="rotateasset_rotasset_tablebody" filterable="true"
displayrowsperpage="14">
    
    <tablecol id="rotateasset_rotasset_tablebody_1"
dataattribute="assetnum" />

    <tablecol id="rotateasset_rotasset_tablebody_2"
dataattribute="location" />

    <tablecol id="rotateasset_rotasset_tablebody_3"
dataattribute="location.description" sortable="false"
    
    </tablebody>

  </table>

  
</table>
```

Rules

This is not a container control.

You can place this control inside the following container controls:
NOTE To view the presentation tag in Application Designer, select Toggle Show All Controls from the Select Action menu.

Example

1 Default Value Properties dialog box configured in Application Designer for Inventory > Inventory > Rotating Assets.

![Default Value Properties](image)

- Control ID: `rotateasset_rotasset_default`
- Attribute: LOCATION
- Value:
- From Data Source ID: MAINRECORD
- From Attribute: LOCATION
- Default Type: QUERY

2 Portion of Associated Assets table with Default Value control displayed in Application Designer.

![Associated Assets](image)

When you perform the query, Maximo populates the Location field for the Query by Example (QBE) with the value of the attribute defined by the From Data Source and From Attribute properties. For example, it copies the value from the Location attribute in the MAINRECORD (Asset Table) to the Location field in the QBE.

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
</tbody>
</table>
A Help Grid is HTML text that you can insert on top of a page or in a Maximo dialog box. The text can function as a label or provide instructions on how to enter data. A Help Grid can have a label and inline HTML text.
Help grids typically appear in dialog boxes within the Maximo user interface. To view dialog boxes in Application Designer, open an application and click the Edit Dialogs button in the toolbar.

**Rules**

This is not a container control.

You can place this control inside the following container controls:

- Section
- Section Column
- Tab
- Dialogs

**Example**

1. Open WOTRACK in Application Designer, then click Edit Dialogs in the toolbar to open Edit Dialogs.

![Edit Dialogs](image1)

<table>
<thead>
<tr>
<th>Control D</th>
<th>Label</th>
</tr>
</thead>
<tbody>
<tr>
<td>searchbook</td>
<td>My Bookmarks</td>
</tr>
<tr>
<td>view_hist</td>
<td>View Work Order History</td>
</tr>
<tr>
<td>report</td>
<td>Sort Reports List</td>
</tr>
<tr>
<td>lookup_select</td>
<td>Select Safety Plan</td>
</tr>
<tr>
<td>select</td>
<td>Select Safety Hazards</td>
</tr>
<tr>
<td>prnalert</td>
<td>View PM Alert Information</td>
</tr>
<tr>
<td>duplicate</td>
<td>Duplicate Record</td>
</tr>
<tr>
<td>displayopen</td>
<td>Display Work Orders Generated</td>
</tr>
<tr>
<td>catalogs</td>
<td>Search Catalogs</td>
</tr>
<tr>
<td>ass_ALLOC</td>
<td>Available Labor</td>
</tr>
<tr>
<td>searchmore</td>
<td>More Search Fields</td>
</tr>
</tbody>
</table>


![Available Labor](image2)

3. Select the "helpgrid..." control and the Control Properties icon to open Help Grid Properties.
**Properties**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The name you assign to the Help Grid control for a specific application. The label you enter is not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>HTML Content</td>
<td>Informational or instructional help text displayed in the Help Grid control.</td>
</tr>
</tbody>
</table>

**HyperLink**

The Hyperlink control supports text and graphics. This control lets you configure a label as a hyperlink. When you click on the label, it can automatically display a menu, a dialog box, or it can take you to an entirely different place within or outside the application. You can, for example, configure a hyperlink to take you to a URL. The Start Center, Go To, and Sign Out links in the Maximo navigation bar are examples of hyperlinks.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- **Section**
Example

1. HyperLink Properties dialog box configured to display the Maximo Go To menu.

![HyperLink Properties dialog box](image)

<table>
<thead>
<tr>
<th>Control ID</th>
<th>new_hyperlink</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>Go To</td>
</tr>
<tr>
<td>Text Alignment</td>
<td>CENTER</td>
</tr>
<tr>
<td>Column</td>
<td></td>
</tr>
<tr>
<td>URL</td>
<td></td>
</tr>
<tr>
<td>Image Filename</td>
<td>btn_goto.gif</td>
</tr>
<tr>
<td>Image Alignment</td>
<td></td>
</tr>
<tr>
<td>Separator</td>
<td>✓</td>
</tr>
<tr>
<td>CSS Classname</td>
<td>powerwhite</td>
</tr>
<tr>
<td>Accesskey</td>
<td></td>
</tr>
<tr>
<td>Control Target ID</td>
<td>pageTitlebar</td>
</tr>
<tr>
<td>Event Type</td>
<td>showmenu</td>
</tr>
<tr>
<td>Event Value</td>
<td>goto</td>
</tr>
</tbody>
</table>

2. Hyperlinks as they appear in the navigation bar for all Maximo applications.

![Hyperlink as they appear in navigation bar](image)

3. Presentation text for navigation bar hyperlink IDs in the library.xml system file.

```xml
<bulletins>
  <!-- Hyperlink IDs for navigation bar -->
  <hyperlink id="bboardlink" label="Bulletins:" mboname="BULLETINBOARD" mxevent="showbboard" classname="powerwhite" image="btn_bboard.gif" accesskey="B" />
  <hyperlink id="gotolink" label="Go To" mxevent="showmenu" targetid="pageTitlebar" eventvalue="goto" classname="powerwhite" image="btn_goto.gif" accesskey="G" />
  <hyperlink id="reportslink" label="Reports" mxevent="showmenu" targetid="pageTitlebar" eventvalue="reportsmenu" classname="powerwhite" image="btn_reporting.gif" accesskey="R" />
</bulletins>
```
HyperLink

Attribute Name | Description
---------------|--------------------------------------------------
Control ID     | A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.

Label          | The name you assign to the Hyperlink control. This value displays in the user interface. You click the label to initiate the link.

The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.

Text Alignment | Select Left, Center, or Right to align the hyperlink label within a section.

Column         | Enter a numeric value in this field that will position the hyperlink at the beginning, middle, or end of a column depending on the Text Alignment setting. By default, each Section control has seven columns that are transparent to the user. For example, if you enter "3" in this field and "Center" for Text Alignment, then Maximo centers the hyperlink above or below column three.

If the hyperlink you want to display is wider than its column, you cannot use the Text Alignment property and Maximo automatically extends the column width to contain the hyperlink.

URL            | If you want the hyperlink to take you to a URL, enter the value here.
<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Image Filename</td>
<td>To add a graphic next to the hyperlink, enter a file name in this field. This field defaults to the path of the images directory so that you do not have to enter the full path for a graphic file. You can specify any type of graphic that a browser is capable of displaying, such as .gif, .jpeg, or .bmps. Some graphic files may require a plug-in. <strong>NOTE</strong> You can place any graphic file into the Maximo library of images. However, if you insert and apply a graphic file without a .gif extension, then you need to rebuild/deploy the Maximo .EAR file.</td>
</tr>
<tr>
<td>Image Alignment</td>
<td>If you associate an image with the Hyperlink control, you can align the image to the right or left of the control label by selecting Right or Left.</td>
</tr>
<tr>
<td>Separator?</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>CSS Classname</td>
<td>Enter the class name for a cascading style sheet. The value you enter can change the layout and appearance of the hyperlink control. The “powerwhite” value entered in the example for this control changes the hyperlink font color to white. You can search for CSS classnames in the following directory: <code>&lt;maximo_root&gt;\applications\maximo\maximouiweb\webmodule\webclient</code></td>
</tr>
<tr>
<td>Access Key</td>
<td>Enter a letter from the hyperlink label to use as part of a keyboard shortcut. For example, the access key for the Go To hyperlink is G. Press ALT + G &lt;enter&gt; to drop down the Maximo main menu. Maximo underlines the access key in the user interface.</td>
</tr>
<tr>
<td>Control Target ID</td>
<td>Enter a Control ID, if different from the current button control, to which the system sends the Event property (if defined) for processing. The Control Target ID for the Go To hyperlink example is &quot;pageTitlebar.&quot;</td>
</tr>
</tbody>
</table>
Images appear in many places throughout the Maximo user interface as visual markers that identify an application you can open or action you can perform. Image icons in the Maximo toolbar represent common functions like Save, Cut, Copy, and Paste. The settings in the Images Properties dialog box enable you to edit the height, width, and alignment for a specified image file.

The image icons you see in the Maximo user interface reside in the following directory:

c:\maximo\applications\maximo\maximouiweb\webmodule\webclient\images

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Event Type</td>
<td>You can link a hyperlink to a user interface operation or &quot;event.&quot; When you click the hyperlink, it triggers the event you specify in this field. The Event Type for the Go To hyperlink is &quot;showmenu.&quot; The &quot;showmenu&quot; event displays the Maximo Go To menu.</td>
</tr>
<tr>
<td>Event Value</td>
<td>Defines the event called when you select a hyperlink. The event value for the Go To menu is &quot;goto.&quot;</td>
</tr>
</tbody>
</table>
You can access the graphic files in the images directory using the Image control in Application Designer.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- **Section**

**Example**

1. Image control dropped into a section in Application Designer.

2. Image Properties dialog box configured to display the Assign Labor icon.

3. Assign Labor image displayed in a section of Application Designer.

**Properties**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
</tbody>
</table>
The Include control is one of the basic controls that Maximo uses together with presentation, page, and client area to create an XML presentation file. The presentation file represents the graphical layout for an application. The presentation control is a container that can include only one page control. The page control differentiates the main page, which uses the browser’s entire client area, from the application’s dialogs. Dialogs display as "popups" in the presentation. A presentation can define its own dialogs or use the Include control to obtain dialog definitions from the library.xml file. The presentation file also uses the Include control to acquire common application functions like header and footer from library.xml.

The client area control differentiates the body of a page or dialog from its header and footer. The client area must contain one or more Sections, a Table,
and/or a Tabgroup that act as containers for all the other controls that comprise the presentation.

The presentation for applications like Incidents, for example, use the Include control to obtain table definitions for the Work and Communication Logs from the library.xml system file. The Include control enables you to import pre-defined layouts from library.xml into different Maximo presentations.

The following example is an extract from the Work Order Tracking application presentation that shows how the include control imports the standard Maximo header and footer definitions from library.xml.

```xml
<presentation id= "wotrack" ... version="6.0.0">
  <page id= "mainrec">
    <include id="pageHeader"/>
    <clientarea id= "clientarea">
      ...
      ...
    </clientarea>
    <include id="pageFooter"/>
  </page>
</presentation>
```

**Rules**

This is not a container control.

You can place this control inside the following container controls:

- Page
- Tab
- Section

**NOTE** To view the page tag in Application Designer, select Toggle Show All Controls from the Select Action menu.
Example

1. Include Properties dialog box configured in Application Designer for Incidents > Log > Work Log.

   ![Include Properties Dialog Box](image)

   - **Control ID**: `worklog`
   - **Control ID to Clone**

2. Work Log table format inherited from "comlog" in library.xml.

   ![Work Log Table](image)

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Control ID to Clone</td>
<td>Enter a Control ID from library.xml. This property enables you to include the same library element multiple times in a presentation.</td>
</tr>
</tbody>
</table>

Listbox

A Listbox is a text type of control that displays a list of selected items in a box that is always open. The Listbox has a text field component or label that is visible in the user interface.

Listbox controls have a Default Label property that enables the control to inherit a read-only label from the attribute you configure for the control. The Default Label value comes from the database object. Alternatively, you can override an inherited Default Label by entering a different value in the Label property. This value is local to the application’s presentation file. Labels you enter at the presentation level are not stored in the MAXATTRIBUTE or MAXLABELS table.

Listboxes display information from the paired Business Object Name and attribute values you specify in the properties dialog box. Additionally, you can
filter what information displays and how it is sorted using the Where Clause and Order By property values.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- ▼ Section

**Example**

No current example for this control. Not widely used in Maximo applications.

**Properties**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label defaults to the text value associated with the database attribute you bound to the Listbox. This is a read only field.</td>
</tr>
<tr>
<td>Label</td>
<td>You can enter a text value in this field that overrides the Default Label value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Height</td>
<td>Enter a numeric value in this field that will increase or decrease the height of the Listbox.</td>
</tr>
<tr>
<td>Width</td>
<td>Enter a numeric value in this field that will increase or decrease the width of the Listbox.</td>
</tr>
<tr>
<td>Bean Class</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Attribute</td>
<td>You can associate a Listbox with a database attribute by using the Select Value dialog box. If the attribute you select has a default label value, it will display in the Default Label field.</td>
</tr>
<tr>
<td>Input Mode</td>
<td>Select one of the options listed below for the Input Mode:</td>
</tr>
</tbody>
</table>

- ▼ Default
- ▼ Password
- ▼ Password Readonly
- ▼ Password Required
- ▼ Query
- ▼ Readonly
- ▼ Required
The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

Input Mode Option Descriptions:

**Default** – sets control to "edit" so you can display or input values and mode is read/write

**Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write

**Password Readonly** – sets control to display asterisks and mode is read only

**Password Required** – sets control to display asterisks and the control is required

**Query** – sets control to display a typed value and mode is read only

**Readonly** – sets control to display grayed-out text and mode is read only

**Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Business Object Name</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Parent Data Source ID</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Order By</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Where Clause</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Auto-Refresh</td>
<td>Select this box if you want the information in the Listbox to automatically refresh whenever there is a change to the MBO.</td>
</tr>
<tr>
<td>Key Attribute</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Key Value</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
The Menubar, short for menu bar, is similar in appearance to the Appbar. The bar that appears at the top of the List tab in most Maximo applications is an example of a menu bar. This menu bar can contain signature security options like Advanced Search, Save Query, and Bookmark. The options in the menu bar usually contain drop-down menus with additional option choices. Advanced Search, for example, has the More Search Fields, Where Clause, and View Search Tips options.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- ▼ Tab

**Example**

1. Menubar Properties dialog box configured in Application Designer.

2. Menubar as it appears in Application Designer workspace.
A Multiline Textbox is a control that displays information or accepts user input in a large box that holds several lines of text. The textbox has a text field component or label that is visible in the user interface. Textboxes are often linked to select value lookups and detailed menus. A select value lookup lets you select and then display a single value from a list of records. A textbox linked to a detailed menu can contain diverse options, such as a select value lookup, jumps to other applications, or views of different records. The Menu Type property you configure for a Textbox controls the format and content of the detailed menu.

Textbox controls have a Default Label property that enables the control to inherit a read-only label from the attribute you configure for the control. The
Default Label value comes from the database object. Alternatively, you can override an inherited Default Label by entering a different value in the Label property. This value is local to the application’s presentation file. Labels you enter at the presentation level are not stored in the MAXATTRIBUTE or MAXLABELS table.

Textboxes display table information from the Data Source ID and Attribute values you specify in the properties dialog box.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- ▼ Section

**Example**

1 Multiline textbox example in Reporting > KPI Manager. The textbox is in the KPI tab and part of the Select Query table.

```sql
Select * select avg(acctfinish-reportdate) from workorder
```
2 The Multiline Textbox Properties dialog box for the preceding KPI example.

![Multiline Textbox Properties dialog box]

### Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label defaults to the text value associated with the database attribute you bound to the textbox. This is a read only field.</td>
</tr>
<tr>
<td>Label</td>
<td>You can enter a text value in this field that overrides the Default Label value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Hide Label?</td>
<td>By default, the label value always appears in the user interface. Select this box to hide the label.</td>
</tr>
<tr>
<td>Columns</td>
<td>The number of columns in the Multiline Textbox. Most Multiline Textboxes in Maximo, including the preceding example, have a column value of &quot;35.&quot; To increase or decrease the width of the box, enter a value greater than or less than &quot;35.&quot;</td>
</tr>
<tr>
<td>Rows</td>
<td>Enter an integer for the number of rows you want in the Multiline Textbox.</td>
</tr>
</tbody>
</table>
Attribute

You can associate a Textbox with a database attribute by using the Select Value dialog box. If the attribute you select has a default label value, it will display in the Default Label field. The Attribute for the preceding example is SELECTTSTMT from the KPIMAIN table.

Data Source ID

The Data Source ID for this control. It points to the main MBO or object that the control uses for entering and displaying data. Each application links to a main object that represents the Parent Data Source for all child controls in the application. Individual or groups of controls within an application can inherit attributes from objects that are not the primary data source. In the preceding example, the table associated with MAINRECORED is KPIMAIN.

See the Data Source ID description for the Combobox control for additional information on data sources.

Lookup

You can enter a value in the Lookup property that links the Textbox to a pre-formatted lookup table. The lookup table pulls records from the main table. Users can populate the Textbox by selecting a record from the table. The value, called a lookup ID, defines the XML presentation content and format of a select value table. WORKORDERISTASK, for example, is the Lookup property for the Parent WO textbox in Work Order Tracking. Lookup ID’s reside in a system XML file called lookups.xml.

You cannot edit system XML files from Application Designer. However, you can view the content of these types of files by selecting a main tab from Application Designer and choosing Select Action > Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the <maximo_root>\resources\presentation\system directory.
Menu Type

You can enter a value in the Menu Type property that links the textbox to a pre-formatted drop-down menu. The value, called a menu ID, defines the XML presentation content and format of a drop-down menu. WORKORDER, for example, is the Menu Type for the Parent WO textbox in Work Order Tracking. Menu ID’s reside in a system XML file called menus.xml.

You cannot edit menus.xml from Application Designer. However, you can view the content of this file or other system .xml files by selecting a main tab from Application Designer and choosing Select Action > Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the <maximo_root>\resources\presentation\system directory.

Input Mode

Select one of the options listed below for the Input Mode:

- Default
- Password
- Password Readonly
- Password Required
- Query
- Readonly
- Required

The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

Input Mode Option Descriptions:

**Default** – sets control to "edit" so you can display or input values and mode is read/write

**Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write

**Password Readonly** – sets control to display asterisks and mode is read only

**Password Required** – sets control to display asterisks and the control is required
A Multipart Textbox is a two-part control that contains side-by-side textboxes that can display information from different sources. You can input information, populate a box by selecting a value from a list, or simply display an attribute description from a table. Typically, a Multipart Textbox in Maximo consists of a text label, a textbox pull-down menu, and an expanded description for an attribute. The source of the information in each textbox can come from separate tables. The layout of the control places information from different sources in the same area of the screen.

Textboxes have labels that are usually visible in the user interface. Labels describe the type of information displayed in the box. Textboxes are often linked to select value lookups and detailed menus. A select value lookup lets you select and then display a single value from a list of records. A Textbox linked to a detailed menu can contain diverse options, such as a Select Value dialog box, jumps to other applications, or views of different records. The Menu Type property you configure for a textbox controls the format and content of the detailed menu.

### Attribute Name | Description
--- | ---
**Query** – sets control to display a typed value and mode is read only

**Readonly** – sets control to display grayed-out text and mode is read only

**Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control

### Data Change Event
You can configure an input control to perform either of the following actions based on any data change to the control:

- **REFRESHTABLE**
- **RESETCHILDREN**

Choosing REFRESHTABLE forces the table that is the data source for the input control to refresh its data. Choosing RESETCHILDREN forces any children of the control’s data bean to delete and reacquire their MBOSetRemote references.

### Move to Data Source ID
The value you enter lets you move to a record stored in a different object. You can select any Data Source ID from the presentation. Refer to the Data Source ID property description.

By default, Maximo sends the Move To event to the ResultsBean, which contains a set of records displayed in the List tab. The Move To event affects the Move to Data Source ID object.
Textbox controls have a Default Label property that enables the control to inherit a read-only label from the attribute you configure for the control. The Default Label value comes from the database object. Alternatively, you can override an inherited Default Label by entering a different value in the Label property. This value is local to the application’s presentation file. Labels you enter at the presentation level are not stored in the MAXATTRIBUTE or MAXLABELS table.

The Multipart Textbox enables you to display a second attribute from the same or a different database table on the same line. Most Maximo applications typically use the second part of a Multipart Textbox to display a full description for an asset, location, or work order number displayed in the first textbox. The example for this control shows that Asset number 11230 is an Emergency Generator.

Textboxes display table information from the Data Source ID and attribute values you specify in the properties dialog box.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- Section

**Example**

1. Asset Number Multipart Textbox in the Work Order tab for the Work Order Tracking application.
2 Asset Number Multipart Textbox Properties dialog box in Application Designer.

### Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label defaults to the text value associated with the database attribute you bound to the textbox. This is a read only field.</td>
</tr>
<tr>
<td>Label</td>
<td>You can enter a text value in this field that overrides the Default Label value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDSETTINGS tables.</td>
</tr>
<tr>
<td>Attribute</td>
<td>You can associate a textbox with a database attribute by using the Select Value dialog box. If the attribute you select has a default label value, it will display in the Default Label field. The example for this control displays a record number of 11230 with a field label of Asset.</td>
</tr>
</tbody>
</table>
### Attribute Name | Description
---|---
**Menu Type** | You can enter a value in the Menu Type property that links the textbox to a pre-formatted drop-down menu. The value, called a menu ID, defines the XML presentation content and format of a drop-down menu. This example uses the pre-formatted menu for assets called ASSETMAIN. Menu ID's reside in a system XML file called menus.xml.

You cannot edit this file from Application Designer. However, you can view the content of this file or other system .xml files by selecting a main tab from Application Designer and choosing Select Action > Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the `<maximo_root>esources\presentation\system` directory.

**Lookup** | You can enter a value in the Lookup property that links the textbox to a pre-formatted lookup table. The lookup table pulls records from the main table. Users can populate the textbox by selecting a record from the table. The value, called a lookup ID, defines the XML presentation content and format of a select value table. ASSET, for example, is the Lookup property for the Multipart Textbox example. Lookup ID's reside in a system XML file called lookups.xml.

You cannot edit system XML files from Application Designer. However, you can view the content of these types of files by selecting a main tab from Application Designer and choosing Select Action > Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the `<maximo_root>esources\presentation\system` directory.
Input Mode

Select one of the options listed below for the Input Mode:

- **Default**
- **Password**
- **Password Readonly**
- **Password Required**
- **Query**
- **Readonly**
- **Required**

The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

Input Mode Option Descriptions:

- **Default** – sets control to "edit" so you can display or input values and mode is read/write
- **Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write
- **Password Readonly** – sets control to display asterisks and mode is read only
- **Password Required** – sets control to display asterisks and the control is required
- **Query** – sets control to display a typed value and mode is read only
- **Readonly** – sets control to display grayed-out text and mode is read only
- **Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control
IBM Maximo: Application Designer Quick Start Guide

Multipart Textbox

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Event</td>
<td>You can configure an input control to perform either of the following actions based on any data change to the control:</td>
</tr>
<tr>
<td></td>
<td>▼ REFRESHTABLE</td>
</tr>
<tr>
<td></td>
<td>▼ RESETCHILDREN</td>
</tr>
<tr>
<td></td>
<td>Choosing REFRESHTABLE forces the table that is the data source for the input control to refresh its data. Choosing RESETCHILDREN forces any children of the control’s data bean to delete and reacquire their MBOSetRemote references.</td>
</tr>
<tr>
<td>Turn Smart Fill Off?</td>
<td>By default, Maximo enables the &quot;Smart Fill&quot; feature. To disable, clear the check box. This feature enables you to enter a partial value in a text box field. Maximo attempts to match the partial text string entered to a valid value(s) in the database. If Maximo finds one matching value, it automatically populates the field so that you can continue entering information. If Maximo finds more than one matching value, it displays a Select Value dialog box with a list of matching values. If you clear the smart fill feature, Maximo does not validate the data you enter in the textbox.</td>
</tr>
<tr>
<td>GOTO Application</td>
<td>You can configure a pull-down menu associated with a textbox to have options that will take the user to different applications. Use the Select Value dialog box for this property to choose application names that will appear in the pull-down menu. In the example for this control, you would see “Go To Assets” as an option in the pull-down menu because the GOTO Application property lists &quot;ASSET&quot; as a value.</td>
</tr>
<tr>
<td>Move to Data Source ID</td>
<td>The value you enter lets you move to a record stored in a different object. You can select any Data Source ID from the presentation. Refer to the Data Source ID definition below.</td>
</tr>
<tr>
<td></td>
<td>By default, Maximo sends the Move To event to the ResultsBean, which contains a set of records displayed in the List tab. The Move To event affects the Move to Data Source ID object.</td>
</tr>
<tr>
<td>Attribute for Part 2</td>
<td>You can associate the second part of a Multipart Textbox with a database attribute by using the Select Value dialog box. Typically, you configure the second part of a multipart control to display the full description information for the record selected in the first part. The example for this control displays Emergency Generator, which is the ASSET.DESCRIPTION for the asset number selected.</td>
</tr>
</tbody>
</table>
Parameter Value

The properties for the Parameter Value control define the dynamic values that display in a Section Header. For example, the task table in Work Order Tracking > Plans tab has a variable value similar to "(0)," where the variable values displayed to the user reflects the attribute configuration setting (i.e., WONUM) in the Parameter Value control.

When you move a section, all of its children, including Section Header and the Parameter Value(s) controls, automatically move with it.

A Parameter Value control works with the following:

- Parameter Values
- Section Header
A Parameter Value is transparent in the Maximo user interface. Section headers along with the Parameter Value and Values controls enable you to display dynamic values in the label for a Table or Section. In the Section Header example, the settings you configure in the Section Header and Parameter Values set xxx in the Table Header to the current WONUM (i.e., 1000).

**Rules**

You can place the following controls in this container control:

- Parameter Values

You can place this control inside the following container controls:

- Section
- Table

You can associate a Parameter Value with Section Headers inserted into Table or section controls. To create a Section Header with dynamic values, complete the following steps:

1. Insert Section Header into a Section or Table control
2. Drag Parameter Values into the Section Header container
3. Parameter Value automatically appears with the Parameter Values control

**Example (See Section Header Example)**

**Properties**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Parameter Position</td>
<td>This property points to the Parameter Values Property field you want to replace. See the Parameter Values Property field for more information.</td>
</tr>
</tbody>
</table>
Parameter Values are container controls that attach to a Section Header and can reside in a Table or Section. This control can hold dynamic values that represent replaceable values in the Section Header label. The Plans tab in the Work Order application, for example, uses the Parameter and Parameter Values controls to display children and tasks of work orders.

The property attribute in the Parameter Values control (e.g., the default is "label") contains the dynamic values defined in the Parameter Value control. For example, the task table in Work Order Tracking > Plans tab has a variable value similar to "(0)", where the variable values displayed to the user is a result of the configuration settings in the Parameter Value and Values controls. The property attribute for the Parameter Values control, for example, has a default value of "label."

When you move a section, all of its children, including Section Header and the Parameter Value(s) controls, automatically move with it.

A Parameter Values control works with the following:

- Parameter Value
- Section Header

Parameter Values are transparent in the Maximo user interface. Section Headers along with the Parameter Value and Values controls enable you to display dynamic values in the label for a Table or Section. In the Section Header example, the settings you configure in the Section Header and

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attribute</td>
<td>Select a data attribute from a data source to display as the Label property in the Table or Section Header.</td>
</tr>
<tr>
<td>Data Source ID</td>
<td>If you want this control to use a different Data Source ID than the default of MAINRECORD, then enter that value here. See the Data Source ID description for the Combobox control for additional information on data sources.</td>
</tr>
</tbody>
</table>

NOTE

You can use the Select Value dialog box to select an attribute from the MAINRECORD or any other table in Maximo. If you enter "=" before the Object name, the dialog box displays only attributes for the table you specify. You can also enter wildcard characters like "%" before or after a text string in the Attribute or Object field to filter your search.
Parameter Values

Parameter Values set xxx in the table header to the current WONUM (i.e., 1000).

Rules

You can place the following controls in this container control:

- Parameter Value

You can place this control inside the following container controls:

- Section
- Table

You can associate Parameter Values with Section Headers inserted into Table or Section controls. To create a Section Header with dynamic values, complete the following steps:

1. Insert Section Header into a Section or Table control
2. Drag Parameter Values into the Section Header container
3. Parameter Value automatically appears with the Parameter Values control

Example (See Section Header Example)

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
</tbody>
</table>
The Property field has a default value of "Label," which is a variable that displays dynamic values inherited from the Parameter Value control in the Table or Section control.

For example, the sample XML from Work Order Tracking > Plans shown below illustrates how Parameter Values and Parameter Value work together to populate the "Children of Work Order (0)" heading with work order numbers.

```xml
<table id="plans_children_table"
    orderby="wosequence"
    label="Children of Work Order {0}" collapsed="true"
collapsible="true"
    relationship="SHOWCHILDREN"
    beanclass="psdi.webclient.beans.workorder.SelectWORecordsBean">
    <sectionheader id="plans_children_table_sectionheader">
        <paramvalues id="plans_children_table_1_sec_params"
            property="label">
            <paramvalue id="plans_children_table_1_sec_param_1"
                position="0" datasrc="MAINRECORD"
dataattribute="wonum" />
        </paramvalues>
    </sectionheader>
</table>
```

The XML shows how (0) is dynamically updated to display the current work order according to the value of the Position attribute. The first position value is 0, the second is 1, and the third is 2, and so on. If the work order in the first position was 1003, then the header for this table would display "Children of Work Order 1003.

The key fields in the XML are:

- **Orderby = wosequence**
  SQL statement that sorts work orders to display in numeric sequence
- **Relationship = SHOWCHILDREN**
  Defines database relationship for showing children work orders

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Property</td>
<td>The Property field has a default value of &quot;Label,&quot; which is a variable that displays dynamic values inherited from the Parameter Value control in the Table or Section control.</td>
</tr>
</tbody>
</table>
A Pushbutton control is a rectangular box with round corners that looks like a button. You push a button to initiate a Maximo event like invoking a dialog box with a list of records or displaying an empty row for entering a new record.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- ▼ Button Group

---

**Attribute Name** | **Description**
--- | ---
Property = label | The Parameter Values Property field that is dynamically updated and passed to the Table Header for display
Position = 0 | Select the work order in the first position
Datasource ID = MAINRECORD | Points to the default data source for the Work Order Tracking application (WORKORDER)
Dataattribute = wonum | Defines the data value (e.g., work order number) to display in the Table Header
Example

1. Pushbutton Properties dialog box configured in Application Designer.

![Pushbutton Properties dialog box](image)

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The name you assign to the button control. The label value identifies the control to the user. If you do not enter a label, the button is blank in the user interface. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Image Filename</td>
<td></td>
</tr>
<tr>
<td>Default Button?</td>
<td></td>
</tr>
<tr>
<td>Menu Type</td>
<td></td>
</tr>
<tr>
<td>Event</td>
<td></td>
</tr>
<tr>
<td>Value</td>
<td></td>
</tr>
<tr>
<td>Target ID</td>
<td></td>
</tr>
</tbody>
</table>

2. Pushbutton as it appears in the Button Group in Application Designer workspace.

![Pushbutton as it appears in the Button Group](image)
### Attribute Name | Description
--- | ---
**Image Filename** | Enter the name of a button-related graphic file, such as btn_next.gif, to insert the image inside of the button. For example, if you have a button called Next, you may want to insert an arrow icon using btn_next.gif. You can specify icons used in Maximo that reside in the following directory: `<maximo_root>\applications\maximo\maximo uiweb\webmodule\webclient\images`

**Default Button?** | Select this field to make a button the active button in a Button Group. Maximo highlights the label text of the active button in the user interface. You may want to make the most frequently used button, for example, New Row, the default button.

**Menu Type** | You can enter a value in the Menu Type property that links the button to a pre-formatted drop-down menu. The value, called a menu ID, defines the XML presentation content and format of a drop-down menu.

Menu ID's reside in a system XML file called menus.xml. You cannot edit this file from Application Designer. However, you can view the content of this file or other system .xml files by selecting a main tab from Application Designer and choosing Select Action > Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the `<maximo_root>\resources\presentation\system directory`. 
A Radio Button is a control that allows users to choose one of a predefined set of options. Radio Buttons appear in groups of two or more. When you select a Radio Button, the previously selected button in the same group is deselected.
Radio Button

Rules

This is not a container control.

You can place this control inside the following container control:

▼ Radio Button Group

Example

1 Radio Button Properties dialog box configured in Application Designer.

![Radio Button Properties dialog box](image)

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label defaults to the text value associated with the database attribute you bound to the Radio Button Group. This is a read only field.</td>
</tr>
</tbody>
</table>

2 Radio Button as it appears in Application Designer workspace.

![Radio Button in workspace](image)
Radio Button Group

A Radio Button Group is a container control that holds Radio Buttons. A Radio Button is a control that allows users to choose one of a predefined set of options. Radio Buttons appear in groups of two or more. When you select a Radio Button, the previously selected button in the same group is deselected. Radio buttons typically appear as little circles that are either empty (for unselected) or contain a dot (selected).

The Radio Button Group defines the layout for the buttons it holds, including a group title, text alignment for button labels, and whether or not to show a border. You can bind a Radio Button Group to a database attribute that automatically populates the group with buttons, label values, and so on. Binding to a database attribute saves time because you do not have to define the individual Radio Button controls for the group. When you make a selection in the Radio Button Group, the value automatically updates the attribute in the database. If you link a Radio Button Group to a database attribute, then you can edit the group in the Database Configuration and Domains applications. Maximo binds most Radio Button Groups to an attribute.

Rules

You can place the following control in this container control:

- Radio Button

You can place this control inside the following container control:

- Section
Example

1. Radio Button Group Properties dialog box for the Set Security Profile dialog. To display, select Go To > Configuration > Application Designer and open the Users application. Choose Edit Dialogs in the toolbar, then select Select Security Profile from the list. Scroll down to the Update Groups section and select Group. This control binds to the GROUPACTION attribute.

![Radio Button Group Properties dialog box](image)

2. Radio Button Group as it appears in Application Designer workspace. This group inherits its buttons and layout from the GROUPACTION attribute.

![Radio Button Group in Application Designer workspace](image)
### Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label defaults to the text value associated with the database attribute you bound to the Radio Button Group. This is a read only field.</td>
</tr>
<tr>
<td>Label</td>
<td>The name you assign to the Radio Button Group control. This value overrides an entry in the Default Label field. The label value identifies the control to the user. If you do not enter a label or inherit a default label, the Radio Button Group title is transparent in the user interface. You can enter a text value in this field that overrides the Default Label value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Hide Label?</td>
<td>Select this field to hide the Label or Default Label value in the user interface.</td>
</tr>
<tr>
<td>Button Orientation</td>
<td>Enter a value of Vertical or Horizontal to align the radio buttons in a group either vertically or horizontally.</td>
</tr>
<tr>
<td>Text Alignment</td>
<td>Select a value of Left, Center, or Right to position button labels relative to the radio button icon. The text label for the button group always displays to the left of any radio buttons you add to the group.</td>
</tr>
<tr>
<td>Show Border?</td>
<td>Select this field to draw a rectangular border around the Radio Button Group.</td>
</tr>
<tr>
<td>Attribute</td>
<td>Select an attribute from a data source to display its label value as the Default Label property for the Radio Button Group. Not all attributes you select will have a database default label value. Additionally, when you bind a Radio Button Group to an attribute, you can inherit a list of Radio Buttons without the need to define the buttons individually with the Radio Button control.</td>
</tr>
</tbody>
</table>
The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

Input Mode Option Descriptions:

**Default** – sets control to "edit" so you can display or input values and mode is read/write

**Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write

**Password Readonly** – sets control to display asterisks and mode is read only

**Password Required** – sets control to display asterisks and the control is required

**Query** – sets control to display a typed value and mode is read only

**Readonly** – sets control to display grayed-out text and mode is read only

**Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control
A Section is a container type of graphical control. Containers occupy real estate on a page and function as storage for other types of controls. A Section is a parent to children controls placed inside it. When you move a Section or other type of container control, its children automatically move with it.

Section controls without labels do not have visible borders and appear transparent in an application page. Sections with labels have a horizontal blue bar with a minimize icon that appear on top of the Section. At a minimum, you start all new application layouts by inserting a Section. Most Maximo applications have multiple pages with many sections and columns. See the Example for information on how to populate a Section control with multiple columns.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Change Event</td>
<td>You can configure an input control to perform either of the following actions based on any data change to the control:</td>
</tr>
<tr>
<td></td>
<td>▼ REFRESHTABLE</td>
</tr>
<tr>
<td></td>
<td>▼ RESETCCHILDREN</td>
</tr>
</tbody>
</table>

Choosing REFRESHTABLE forces the table that is the data source for the input control to refresh its data. Choosing RESETCCHILDREN forces any children of the control’s data bean to delete and reacquire their MBOSetRemote references.

| Value Attribute     | Optionally, if you do not automatically populate a Radio Button Group with a list of buttons, you can enter a data value in this field that automatically updates the database when you select a button. For example, if you have a button with a Description Attribute of "Waiting for Approval," you might define the Value Attribute as "WAPPR." Maximo writes "WAPPR" to the database and displays "Waiting for Approval" in the user interface. |

| Description Attribute | Optionally, you can lookup or enter a data attribute that displays a text label for the Value Attribute in the user interface. See Value Attribute. |

<table>
<thead>
<tr>
<th>Data Source ID</th>
<th>If you want this control to use a different Data Source ID than the default of MAINRECORD, then enter that value here.</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>See the Data Source ID description for the Combobox control for additional information on data sources.</td>
</tr>
</tbody>
</table>
Sections are one of the primary components of the Maximo user interface. A Section is typically an application page that you can expand or minimize. Sections contain groupings of fields that hold similar or related data. Additionally, most Maximo tabs have many parent and children Sections that allow you to layout and define the user interface. Controls within Sections display information or accept user input.

Rules

You can place the following controls in this container control:

- Attachments
- Blank Line
- Button Group
- Checkbox
- Combobox
- Data Source
- Default Value
- Hyperlink
- Image
- Include
- Listbox
- Multiline Textbox
- Radio Button Group
- Section Header
- Section Row
- Static Text
- Textbox

You can place this control inside the following container controls:

- Dialogs
- Tab
- Table
- Section Columns

Example

1. Section container with Section Row.

2. Section container with a Textbox.
## Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The name you assign to the Section control. The label value identifies the control to the user. If you do not enter a label, the Section is transparent in the user interface and does not have a title. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Show Border?</td>
<td>If you have added a Label, selecting this box also adds blue horizontal rules to the top and bottom of the Section. The border property does not work without a defined label.</td>
</tr>
<tr>
<td>Collapsed?</td>
<td>Selecting this box collapses a Section and its contents if you have defined a Label for the Section. You see the collapsed Section when you run the application, but not in Application Designer workspace. To expand a section in the user interface, click the Maximize Section icon in the application.</td>
</tr>
<tr>
<td>Description</td>
<td>Text you enter in this field displays under the Section’s label in the title bar.</td>
</tr>
</tbody>
</table>
Data Source ID If you want this control to use a different Data Source ID than the default of MAINRECORD, then enter that value here.

Each Maximo application has a presentation file that represents the graphical layout of the application pages displayed in a browser window. Each presentation file has a Presentation ID tag that can include any number of controls, dialogs, and data sources.

The Presentation ID tag defines the main Maximo Business Object (MBO) for the application. For example, the MBO for the Work Order application is WORKORDER.

The example below shows the first line of XML text in the Work Order Tracking presentation.

```
<presentation id="wotrack"
resultstableid="results_showlist"
mboname="WORKORDER" orderby="WONUM"
beanclass="psdi.webclient.beans.workorder.WorkorderAppBean" version="6.0.0">

<page id="mainrec">

Although the controls within an application can inherit data from different data sources, the default data source is always "MAINRECORD." In Work Order Tracking, any control whose Data Source ID is MAINRECORD pulls data from the WORKORDER table. MAINRECORD is the Parent Data Source ID for the presentation. To have individual controls inherit data from a different source, you must define a different Parent Data Source ID.

See the Data Source ID description for the Combobox control for additional information on data sources.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source ID</td>
<td>If you want this control to use a different Data Source ID than the default of MAINRECORD, then enter that value here.</td>
</tr>
</tbody>
</table>
Business Object

The main MBO reference for the application. For example, Work Order Tracking uses WOTRACK and Assets uses ASSET.

Every Maximo application works with a MBO and MBOSet. The set of work orders displayed on the List tab in the Work Order Tracking application, for example, is a MBOSet. Each individual work order is a MBO. An application’s presentation tag defines the main MBO for the application. MBOs are responsible for the following types of functions:

- Field validation
- Updating the database
- Business processing logic

By default, the presentation tag for an application defines the main MBO to use when saving or displaying data through the user interface. All controls in the application share the same MBO reference via the Parent Data Source ID property. Unless overridden, all controls added to an application bind to the Parent Data Source ID. If you wish an individual control to display and process information from a different MBO, you can enter a different Parent Data Source ID.

Parent Data Source ID

If you wish this Section control to inherit data from a source other than MAINRECORD, enter that value in this field. You might, for example, want to define a new parent data source in an application like Work Order Tracking where a table needs to pull data from an object other than WORKORDER. The Parent Data Source ID lets you build relationships with a different data source using Where Clauses.
Input Mode Option Descriptions:

**Default** – sets control to "edit" so you can display or input values and mode is read/write

**Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write

**Password Readonly** – sets control to display asterisks and mode is read only

**Password Required** – sets control to display asterisks and the control is required

**Query** – sets control to display a typed value and mode is read only

**Readonly** – sets control to display grayed-out text and mode is read only

**Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control

Enter the ID(s) of one or more controls whose display values will be refreshed based on changes to this data source. Control ID(s) can reside anywhere inside the application. You must separate multiple values with a comma.
Section Column

A Section Column is a vertical column control that lets you divide a Section Row into headings. A Section Column is a container that can hold child sections. A Section Column is a child to a parent section. When you move a Section, all of its children automatically move with it.

You can insert Section columns into Section Rows. When you drag a Section Column into a Section Row, it automatically creates two Section Columns. A Section Column does not have a label. Its only function is to hold child sections. A child section can hold, for example, a Section Header that lets you assign column headings for a multi-column section.

Sections Columns like Section Rows are transparent in the Maximo user interface. Except for tables, all graphical elements in Maximo that have multiple columns have a transparent Section Column within a Section Row that is within a parent section.

Rules

You can place the following control in this container control:

- Section

You can place this control inside the following container control:

- Section Row

Example

To create a multi-column section layout, complete the following steps:

1. Insert Section
2. Insert Section Row
3. Insert a Section Column

To create a multi-column section layout with a child section, complete the following steps:

1. Insert Section
2. Insert Section Row
3 Insert Section Columns (to subdivide the section into columns)

4 Drop a new section into each Section Column

5 Add controls to each new Section

NOTE To view the page tag in Application Designer, select Toggle Show All Controls from the Select Action menu.

1 You can drop Section Columns into Section Rows, but not Sections.

2 You use Section Columns to subdivide a Section, but you cannot drop controls into a Section Column.

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
</tbody>
</table>

Section Header

A Section Header is a control that can contain dynamic values in its label. The Plans tab in the Work Order application, for example, uses the Section Header and related Parameter and Parameter Values controls to display children and tasks of work orders. The Section Header is a container control.

Use this control to assign a column or table heading for a Section or Table. A Section Header can contain replaceable values depending on how you configure the Parameter Value and Parameter Values controls. For example, the label attribute for the Section Header in the task table in Work Order Tracking > Plans tab has a variable value similar to "(0)," where the variable value is defined by the Parameter Value control. When you move a Section, all of its children, including Section Header and related controls, automatically move with it.

Sections Headers are transparent in the Maximo user interface. To view a grouping of Section Header, Parameter Values, and Parameter Value controls in Application Designer, you must choose Select Action > Toggle Show All Controls from a tab. Section Headers along with the Parameter Value and Values controls enable you to display dynamic values in the "Tasks for Work"
Order xxxx" label for the table in the previous example. The settings you configure in the Section Header and Parameter Values set "xxx" in the header to the current WONUM (i.e., 1000).

**Rules**

You can place the following control in this container control:

- Parameter Value
- Parameter Values

You can place this control inside the following container controls:

- Section
- Table

**Example (Work Order Tracking > Plans > Task Table)**

To create a Section Header with dynamic values, complete the following steps:

1. Insert Section Header into a Section or Table control
2. Drag Parameter Values into the Section Header container
3. Parameter Value automatically appears with the Parameter Values control

Work Order Tracking (WOTRACK) Section Header opened in Application Designer:

![Work Order Tracking Section Header](image)

Work Order Tracking Section Header as it appears in Maximo:

![Tasks for Work Order 1000](image)
Work Order Tracking Section Header dialog box as it appears in Application Designer:

```
Control ID  plans_task_table_sectionheader
Label*       
Plain Text?  
Data Source ID plano_task_table
```

### Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The label contains a variable that displays dynamic values inherited from the Parameter Value and Values controls in the Table or Section control.</td>
</tr>
<tr>
<td>Plain Text</td>
<td>Any text you enter in this field removes the CSS (cascading style sheet) class definition for a label so that it looks like plain text in the user interface.</td>
</tr>
<tr>
<td>Data Source ID</td>
<td>If you want this control to use a different Data Source ID than the default of MAINRECORD, then enter that value here.</td>
</tr>
</tbody>
</table>

Each Maximo application has a presentation file that represents the graphical layout of the application pages displayed in a browser window. Each presentation file has a Presentation ID tag that can include any number of controls, dialogs, and data sources.

The Presentation ID tag defines the main Maximo Business Object (MBO) for the application. For example, the MBO for the Work Order application is WORKORDER.

See the Data Source ID description for the Combobox control for additional information on data sources.
Section Row

A Section Row is a container type of graphical control that holds Section Columns. A Section Row is a horizontal row that lets you partition a Section into columns that in turn hold child sections. A Section Row is a child to a parent section. When you move a Section, all of its children automatically move with it.

You can insert Section Columns into Section Rows. A Section Row does not have a label. Its only function is to hold Section Columns. Sections Rows are transparent in the Maximo user interface. Except for tables, all graphical elements in Maximo that have multiple columns have a transparent Section Row within a Section.

Rules

You can place the following control in this container control:

- Section Column

You can place this control inside the following container control:

- Section

Example

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
</tbody>
</table>

Static Text

Static Text is a text control that lets you enter and configure free form text in a Section. It also lets you specify a database attribute that you can configure and position within a Section as if it were unbound text. You can position static text using the Text Alignment, Column, or Span properties. You typically see applications use static text in Date search dialog boxes. The
Static Text

static text functions as a To or From label in a Date Search dialog box like the SEARCHMORE dialog in Work Order Tracking.

In addition to configuring Static Text to function as a plain text label, you can configure the plain text to behave as a hyperlink that will take you to a URL when clicked. When configured as a URL, the Static Text uses a larger font and looks more like a URL string than plain text.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- **Section**

**Example**

1. Static Text Properties dialog box configured in Application Designer.

   ![Static Text Properties dialog box](image1)

   - **Control ID**: new_statictext
   - **Default Label**: Enter Text...
   - **Text Alignment**: LEFT
   - **Column**: 1
   - **Span**: 
   - **Attribute**: 
   - **Display as Link?**: 
   - **Display as Plain Text?**: 

2. Static Text example as it appears in Application Designer workspace.

   ![Static Text example](image2)
# Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label defaults to the text value associated with the database attribute you bound to the Listbox. This is a read only field.</td>
</tr>
<tr>
<td>Label</td>
<td>You can enter a text value in this field that overrides the Default Label value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Text Alignment</td>
<td>Select Left, Center, or Right to align Static Text within this control. Typically, you associate static text with a control that resides in a Section. You can place the text above or below the control.</td>
</tr>
<tr>
<td>Column</td>
<td>Enter a numeric value in this field that will position the static text at the beginning, middle or end of a column depending on the Text Alignment setting. By default, each control has seven columns that are transparent to the user. For example, if you enter &quot;3&quot; in this field and &quot;Center&quot; for Text Alignment, then Maximo centers the Static Text above or below column three. If the Static Text you want to display is wider than its column, you cannot use the Text Alignment property and Maximo automatically extends the column width to contain the Static Text.</td>
</tr>
<tr>
<td>Span</td>
<td>Enter a numeric value in this field that will enable the Static Text to bridge one or more columns.</td>
</tr>
<tr>
<td>Attribute</td>
<td>You can associate static text with a database attribute by using the Select Value dialog box. If the attribute you select has a default label value, it will display in the Default Label field.</td>
</tr>
<tr>
<td>Display as Link?</td>
<td>By default, Static Text does not display as a URL link. Select this field to configure the control as a URL link.</td>
</tr>
<tr>
<td>Display as Plain Text?</td>
<td>Any text you enter in this field removes the CSS (cascading style sheet) class definition for a label so that it looks like plain text in the user interface.</td>
</tr>
</tbody>
</table>
Tab

A Tab is a container control. Formatting a Tab(s) is the starting point for designing the structure and layout of a new application or extending the layout of an existing application. You would typically add a Section control as the first element in a Tab and then add other controls to complete your screen layout. For example, you can break the layout of the page vertically by adding additional Section controls. Also, you can break a section horizontally by adding Section Columns.

Rules

You can place the following controls in this container control:

- Data Source
- Menubar
- Table
- Section
- Help Grid
- Include
- Tree

You can place this control inside the following container controls:

- Tabgroup

Example

1. Tab Properties dialog box configured in Application Designer.
2 New Tab as it appears in Application Designer workspace.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The name you assign to the Tab control for a specific application. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Type</td>
<td>Select the type of tab you want to add to the Tabgroup. Valid values are List or Insert. Choosing List formats the tab as a standard Maximo search tab with a filter table. Choosing Insert formats the tab as an empty workspace where you can build an application screen by inserting and configuring controls.</td>
</tr>
<tr>
<td>Default?</td>
<td>This property indicates which tab, either a List or Insert, to enable when you first open an application and display a record. When you create a new power application, List tab is the default.</td>
</tr>
<tr>
<td>Bean Class</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Business Object</td>
<td>The main MBO reference for the application. For example, Work Order Tracking uses WOTRACK and Assets uses ASSET.</td>
</tr>
<tr>
<td></td>
<td>Every Maximo application works with a MBO and MBOSet. The set of work orders displayed on the List tab in the Work Order Tracking application, for example, is a MBOSet. Each individual work order is a MBO. An application’s presentation tag defines the main MBO for the application. MBOs are responsible for the following types of functions:</td>
</tr>
</tbody>
</table>
|                     | - Field validation  
|                     | - Updating the database  
|                     | - Business processing logic |
|                     | By default, the presentation tag for an application defines the main MBO to use when saving or displaying data through the user interface. All controls in the application share the same MBO reference via the Parent Data Source ID property. Unless overridden, all controls added to an application bind to the Parent Data Source ID. If you wish an individual control to display and process information from a different MBO, you can enter a different Parent Data Source ID. |
| Parent Data Source ID | If you wish the Tab control to inherit data from a source other than MAINRECORD, enter that value in this field. You might, for example, want to define a new parent data source in an application like Work Order Tracking where the tab and its children controls pull data from an object other than WORKORDER. The Parent Data Source ID lets you build relationships with a different data source using Where Clauses. |
| Relationship         | You enter a relationship value in this field. You can search for values in the Database Configuration > Relationships tab. If you enter a relationship, it is automatically inherited by any input child controls within the tab. Relationships enable controls to display or write to different Maximo business objects. |
| Order By             | Reserved for future use.                                                                                                                   |
| Where Clause         | Reserved for future use.                                                                                                                   |
| Listeners            | Enter the ID(s) of one or more controls whose display values will be refreshed based on changes to this data source. Control ID(s) can reside anywhere inside the application. You must separate multiple values with a comma. |
Tab Group

A Tabgroup is a container type of control that holds tabs. Tabgroups are part of the template for power applications. When you create a new power application, you will see a Tabgroup control with the standard Maximo List and Main (workspace) tabs. You can add additional tabs as required by your business application.

Rules

You can place the following control in this container control:

▼ Tab

Example

The Tabgroup control as it appears in Application Designer when you create a new power application.

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Format</td>
<td>Leave blank (the default) or choose one of the following layout options:</td>
</tr>
<tr>
<td></td>
<td>▼ CARDECK</td>
</tr>
<tr>
<td></td>
<td>▼ DEFAULT</td>
</tr>
<tr>
<td></td>
<td>▼ WIZARD</td>
</tr>
<tr>
<td>Style</td>
<td>The wizard option replaces the standard Maximo tab layout with arrows that point to the tab headings. The cardeck option appears in single-page applications that do not employ tabs.</td>
</tr>
<tr>
<td>Change Event</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
The Table control is a container control with the basic layout elements of a table window, including a toolbar with filter and search functionality and icons for previous/next row and page. The basic Table layout also includes a Table Column control and a details box where you can enter a Section. The Table control is similar to the table window in the List tab of most Maximo applications. Maximo tables enable you to search for and display records from one or more tables in a columnar format. You can use the standard filter feature to display only records that meet specified criteria.

Rules

You can place the following controls in this container control:

- Table Column
- Section

You can place this control inside the following container controls:

- Section Column
- Tab
- Dialog Box

**Note**

You can insert a Section control into the details section of a Table window. The details section is an empty, rectangular box at the bottom of the window.

Example

1. Section control dropped into a Tab container. Section Row dropped into the Section container. Section Column dropped into the Section Row.

2. Table control dropped into the Section Column.
Table Properties dialog box in Application Designer.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Label</td>
<td>The text value you enter becomes the title of the table and displays in the toolbar. Maximo stores this value in the MAXLABELS table. You can edit this value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Width</td>
<td>Enter a numeric value to resize the width of a table. The default window size for a table is approximately 1000, or the full width of a page. You can decrease the width of a table to approximately 400. The table control needs a width of 400 to maintain the contents of the toolbar, including table title and icons.</td>
</tr>
<tr>
<td>Description</td>
<td>Text you enter in this field displays under the Table's label in the title bar.</td>
</tr>
<tr>
<td>Title Attributes</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Start Empty?</td>
<td>Select this box if you want the table to always open without displaying records. If you leave this box cleared (the default), Maximo automatically populates the table with records that match the search query when opened.</td>
</tr>
<tr>
<td>No Row Messages</td>
<td>By default, you see the message &quot;No rows to display&quot; when you open a table without rows. To override the default text message, enter a value in this field.</td>
</tr>
<tr>
<td>No Row Message</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Filter Expanded?</td>
<td>Select this box if you want to display an empty query filter row when you open a table. If cleared, the default, the filter row does not display with an open table. See also Filterable?.</td>
</tr>
<tr>
<td>Row Details Expanded?</td>
<td>Select this box if you want a table to display the expanded detail sections for each record in the table. The default is not to expand the detail sections for a table row.</td>
</tr>
<tr>
<td>Collapsible?</td>
<td>Select this box to enable the Show/Hide icons in the table toolbar. You must select this field to use the &quot;Collapsed?&quot; property. By default, this property is cleared.</td>
</tr>
<tr>
<td>Collapsed?</td>
<td>If you selected &quot;Collapsible?&quot;, then you can select this box to display only the table title and not any row details when you open a table in an application. By default, this property is cleared.</td>
</tr>
<tr>
<td>Collapsed Empty Label</td>
<td>When a table is collapsed and empty, the value you enter here will override the table title (i.e., Label property) in the user interface.</td>
</tr>
<tr>
<td>Collapsed Label</td>
<td>When a table is collapsed, the value you enter here will override the table title in the user interface.</td>
</tr>
<tr>
<td>Parent Empty Label</td>
<td>If this table is a child of a parent table, and that table is empty, the value you enter here will override the parent’s table title.</td>
</tr>
<tr>
<td>Bean Class</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
### Select Mode

You can restrict a table to displaying one or multiple records from a database table. You can choose either Multiple or Single. The Work Order Tracking list table, for example, has this field set to "MULTIPLE."

### Input Mode

Select one of options listed below for the Input Mode:

- **Default**
- **Password**
- **Password Readonly**
- **Password Required**
- **Query**
- **Readonly**
- **Required**

The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

### Input Mode Option Descriptions:

- **Default** – sets control to "edit" so you can display or input values and mode is read/write
- **Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write
- **Password Readonly** – sets control to display asterisks and mode is read only
- **Password Required** – sets control to display asterisks and the control is required
- **Query** – sets control to display a typed value and mode is read only
- **Readonly** – sets control to display grayed-out text and mode is read only
- **Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control

---

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select Mode</td>
<td>You can restrict a table to displaying one or multiple records from a database table. You can choose either Multiple or Single. The Work Order Tracking list table, for example, has this field set to &quot;MULTIPLE.&quot;</td>
</tr>
<tr>
<td>Input Mode</td>
<td>Select one of options listed below for the Input Mode:</td>
</tr>
<tr>
<td></td>
<td>▼ Default</td>
</tr>
<tr>
<td></td>
<td>▼ Password</td>
</tr>
<tr>
<td></td>
<td>▼ Password Readonly</td>
</tr>
<tr>
<td></td>
<td>▼ Password Required</td>
</tr>
<tr>
<td></td>
<td>▼ Query</td>
</tr>
<tr>
<td></td>
<td>▼ Readonly</td>
</tr>
<tr>
<td></td>
<td>▼ Required</td>
</tr>
</tbody>
</table>
The Data Source ID for this control. It points to the main MBO or object that the control uses for entering and displaying data. Each application links to a main object that represents the Parent Data Source for all child controls in the application. Individual or groups of controls within an application can inherit attributes from objects that are not the primary data source.

See the Data Source ID description for the Combobox control for additional information on data sources.

The main MBO reference for the application. For example, Work Order Tracking uses WOTRACK and Assets uses ASSET.

Every Maximo application works with a MBO and MBOSet. The set of work orders displayed on the List tab in the Work Order Tracking application, for example, is a MBOSet. Each individual work order is a MBO. An application’s presentation tag defines the main MBO for the application. MBOs are responsible for the following types of functions:

- Field validation
- Updating the database
- Business processing logic

By default, the presentation tag for an application defines the main MBO to use when saving or displaying data through the user interface. All controls in the application share the same MBO reference via the Parent Data Source ID property. Unless overridden, all controls added to an application bind to the Parent Data Source ID. If you wish an individual control to display and process information from a different MBO, you can enter a different Parent Data Source ID.

The Parent Data Source ID points to the main MBO associated with an application, for example, WOTRACK. Unless overridden, all controls inherit the value stored in the application’s presentation tag.

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source ID</td>
<td>The Data Source ID for this control. It points to the main MBO or object that the control uses for entering and displaying data. Each application links to a main object that represents the Parent Data Source for all child controls in the application. Individual or groups of controls within an application can inherit attributes from objects that are not the primary data source. See the Data Source ID description for the Combobox control for additional information on data sources.</td>
</tr>
<tr>
<td>Business Object</td>
<td>The main MBO reference for the application. For example, Work Order Tracking uses WOTRACK and Assets uses ASSET. Every Maximo application works with a MBO and MBOSet. The set of work orders displayed on the List tab in the Work Order Tracking application, for example, is a MBOSet. Each individual work order is a MBO. An application’s presentation tag defines the main MBO for the application. MBOs are responsible for the following types of functions: - Field validation - Updating the database - Business processing logic By default, the presentation tag for an application defines the main MBO to use when saving or displaying data through the user interface. All controls in the application share the same MBO reference via the Parent Data Source ID property. Unless overridden, all controls added to an application bind to the Parent Data Source ID. If you wish an individual control to display and process information from a different MBO, you can enter a different Parent Data Source ID.</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Relationship</td>
<td>You enter a relationship value in this field. You can search for values in the Database Configuration &gt; Relationships tab. If you enter a relationship, it is automatically inherited by any input child controls within the table. Relationships enable a table to display information from different Maximo business objects. For example, if you entered SPAREPART, the table will be able to display information based on the defined relationship. When you enter a relationship in the Table control, it automatically prefixes any child column attributes added to the table. So, for SPAREPART, you only have to enter the column attribute name and not the full relationship of SPAREPART &lt;attribute&gt;.</td>
</tr>
<tr>
<td>Order By</td>
<td>Enter the name of an attribute to use when sorting information in the table. For example, you can sort on QUANTITY to list records according to their numeric value. If you enter ASC QUANTITY, the table displays records in ascending order from the lowest to the highest numeric value. If you enter DSC QUANTITY, the table displays records in descending order from the highest to the lowest numeric value.</td>
</tr>
<tr>
<td>Application</td>
<td>Enter a Where Clause that filters information displayed in the table. If you enter a restriction, it modifies the overall Where Clause for the application. You cannot change the restriction at runtime.</td>
</tr>
<tr>
<td>Restrictions</td>
<td>Enter a Where Clause that filters information displayed in the table. If you enter a restriction, it modifies the overall Where Clause for the application. You cannot change the restriction at runtime.</td>
</tr>
<tr>
<td>Listeners</td>
<td>Enter the ID(s) of one or more controls whose display values will be refreshed based on changes to this data source. Control ID(s) can reside anywhere inside the application. You must separate multiple values with a comma.</td>
</tr>
<tr>
<td>Display Rows Per Page</td>
<td>The maximum number of rows you wish to display on a page.</td>
</tr>
<tr>
<td>Filterable?</td>
<td>This field adds a filter row for searching to the table. It defaults to enable. This setting automatically passes to the Filterable? property in all Table Column controls. You must select this box to use the Filter Expanded? property. See also Filter Expanded?</td>
</tr>
<tr>
<td>Customizable?</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
Table Column

The Table Column control is a container type control that lets you define additional column headings for a table. Maximo columns let you display or insert data from tables. You can use the standard filter feature to display only records that meet specified criteria.

Rules

You can place the following controls in this container control:

- Checkbox
- Textbox

You can place this control inside the following container controls:

- Table

Example

1. Table Column dropped into a table.
Table Column Properties dialog box in Application Designer.

### Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label, which becomes the Table Column heading, defaults to the text value associated with the database attribute entered in the Attribute property. For example, if you enter ASSETNUM as the attribute, the Default Label becomes Asset. This is a read only field.</td>
</tr>
</tbody>
</table>
### Table Column

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Label</td>
<td>The text value you enter here replaces the Default Label as the Table Column heading. Maximo stores this value in the MAXLABELS table. You can edit this value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Label Attributes</td>
<td>You can enter a comma separated list of data attributes to use when building the Default Label for this control. The Label Attributes and Label Source ID properties enable you to display dynamic values in the Default Label for a Table Column.</td>
</tr>
<tr>
<td>Label Source ID</td>
<td>Enter an object name that is the data source for the Label Attributes property.</td>
</tr>
<tr>
<td>Title Attributes</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>CSS Class Name</td>
<td>Enter the class name for a cascading style sheet. The value you enter can change the layout and appearance of the Table Column. Typically, you would not use this field with a Table Column control.</td>
</tr>
<tr>
<td>Show Filter?</td>
<td>If you select the Filterable? and Show Filter? properties, you will see the filter Textbox control for this column in the table’s filter row.</td>
</tr>
<tr>
<td>Filterable?</td>
<td>If you select the Table control’s Filterable? property, it automatically passes this setting to the Filterable? property in each Table Column. You can select or clear Filterable? at the table column level. Filterable?, when selected, indicates that you can search on the attribute associated with the Table Column label.</td>
</tr>
<tr>
<td>Sortable?</td>
<td>If selected, you can sort the records in the table by clicking on the column’s label. The first time you click on a label it sorts the records in ascending order for that column’s values. The second time you click a label, it sorts the records in descending order.</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>You can link a Table Column to events and links. If you select Event, it maps the column to an event type, description, and icon. BOOKMARK and TOGGLEDETAILSTATE are event examples. Link adds an underline to a value, usually a record number, which causes the detail record to open when you select the value. In the Related Work Orders tab there is an event column before the Work Order Number column called &quot;toggledetailstate&quot; with a description of &quot;Show Detail.&quot; This column places a View/Show Details icon next to the work order number column that lets you open or close the details section for a selected work order. The Work Order Number column in the Work Order List tab has a Type value of Link. Link adds an underline to all work order numbers that appear in the column.</td>
</tr>
<tr>
<td><strong>Attribute</strong></td>
<td>You can associate a Table Column with a database attribute by using the Select Value dialog box. For example, if you enter ASSETNUM in the Attribute field, Maximo populates the Default Label with &quot;Asset.&quot; This column displays asset numbers and &quot;Asset&quot; displays as the Table Column heading. Not all attributes you select will have a database default label value.</td>
</tr>
<tr>
<td><strong>Linked Controls ID</strong></td>
<td>You can enter a Control ID here that gets automatically updated whenever there is a change to this column’s attribute value. The Control ID must reside somewhere within the application.</td>
</tr>
<tr>
<td><strong>GOTO Application</strong></td>
<td>You can configure a pull-down menu associated with a Table Column to have options that will take the user to different applications. Use the Select Value dialog box for this property to choose application names that will appear in the pull-down menu.</td>
</tr>
</tbody>
</table>
Input Mode

Select one of options listed below for the Input Mode:

- **Default**
- **Password**
- **Password Readonly**
- **Password Required**
- **Query**
- **Readonly**
- **Required**

The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

Input Mode Option Descriptions:

**Default** – sets control to "edit" so you can display or input values and mode is read/write

**Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write

**Password Readonly** – sets control to display asterisks and mode is read only

**Password Required** – sets control to display asterisks and the control is required

**Query** – sets control to display a typed value and mode is read only

**Readonly** – sets control to display grayed-out text and mode is read only

**Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control
Menu Type

You can enter a value in the Menu Type property that links the Table Column to a pre-formatted drop-down menu. The value, called a menu ID, defines the XML presentation content and format of a drop-down menu. WORKORDER, for example, is the Menu Type for the Parent WO textbox in Work Order Tracking. Menu ID’s reside in a system XML file called menus.xml.

You cannot edit this file from Application Designer. However, you can view the content of this file or other system .xml files by selecting a main tab from Application Designer and choosing Select Action > Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the <maximo_root>\resources\presentation\system directory.

Lookup

You can enter a value in the Lookup property that links the Table Column to a pre-formatted lookup table. The lookup table pulls records from the main table. Users can populate the Table Column by selecting a record from the table. The value, called a lookup ID, defines the XML presentation content and format of a select value table. WORKORDERISTASK, for example, is the Lookup property for the Parent WO textbox in Work Order Tracking. Lookup ID’s reside in a system XML file called lookups.xml.

You cannot edit system XML files from Application Designer. However, you can view the content of these types of files by selecting a main tab from Application Designer and choosing Select Action > Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the <maximo_root>\resources\presentation\system directory.

Change Event

You can configure an input control to perform either of the following actions based on any data change to the control:

- REFRESHTABLE
- RESETCHILDREN

Choosing REFRESHTABLE forces the table that is the data source for the input control to refresh its data. Choosing RESETCHILDREN forces any children of the control’s data bean to delete and reacquire their MBOSetRemote references.
### Table Column

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Turn Smart Fill Off?</td>
<td>By default, Maximo enables the &quot;Smart Fill&quot; feature. To disable, clear the check box. This feature enables you to enter a partial value in a text box field. Maximo attempts to match the partial text string entered to a valid value(s) in the database. If Maximo finds one matching value, it automatically populates the field so that you can continue entering information. If Maximo finds more than one matching value, it displays a Select Value dialog box with a list of matching values. If you clear the smart fill property, Maximo does not validate the data you enter in the textbox.</td>
</tr>
<tr>
<td>Is LD Readonly?</td>
<td>By default, Maximo sets a Long Description associated with a Table Column attribute to editable. Select this field to make the Long Description read only.</td>
</tr>
<tr>
<td>URL Attribute</td>
<td>Enter a URL value if you set the Type property for this control to &quot;Link.&quot; The URL value becomes a hyperlink.</td>
</tr>
</tbody>
</table>
| Event              | If you select "Event" as the Type property for a Table Column, Maximo performs the action defined in this field. Continuing the example for the Type property above, entering "toggledetailstate" lets you view or close the details section of a work order. Users can also define their own events. Virtually every action you perform in Maximo, such as clicking Next or saving a record, triggers an event. Events defined in a presentation file are tied to a method in the code or an event tag in the JSP pages. Maximo is an event driven product. When you perform an action, Maximo sends an "Event" to the back end which invokes and runs a method associated with the event. There is no directory listing of events, however, you can search for events and event descriptions in presentations using the search words "mxevent" and "mxevent_desc."  
See also Type. |
| Event Description  | Indicates the tool tip that appears above a selected field or icon. For example, "Mark row for deletion" or "View Details."  
See also Event. |
Textbox

A Textbox control is a single line text input box that displays information you enter or select from a list. Textboxes have labels that are usually visible in the user interface. Labels are text fields that describe the type of information displayed in the box.

Textboxes are often linked to select value lookups and detailed menus. A select value lookup lets you select and then display a single value from a list of records. A Textbox linked to a detailed menu can contain diverse options, such as a Select Value dialog box, jumps to other applications, or views of different records. The Menu Type property you configure for a Textbox controls the format and content of the detailed menu.

Textbox controls have a Default Label property that enables the control to inherit a read-only label from the attribute you configure for the control. The Default Label value comes from the database object. Alternatively, you can override an inherited Default Label by entering a different value in the Label property. This value is local to the application’s presentation file. Labels you enter at the presentation level are not stored in the MAXATTRIBUTE OR MAXLABELS table.

Textbox controls display object information from the Data Source ID and attribute values you specify in the properties dialog box.

**Rules**

This is not a container control.

You can place this control inside the following container control:

- Section
Example

1  Parent WO textbox field in the Work Order Tracking application.

![Image of Work Order Tracking application with Parent WO field highlighted]

2  Detailed menu for the Parent WO field.

![Image of detailed menu for Parent WO field]

3  Select value table row for the Parent WO field.

![Image of select value table for Parent WO field]

Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Default Label</td>
<td>This label defaults to the text value associated with the database attribute you bound to the textbox. This is a read-only field.</td>
</tr>
<tr>
<td>Label</td>
<td>You can enter a text value in this field that overrides the Default Label value. The label you enter here is specific to the application and not stored in the MAXATTRIBUTE or APPFIELDDEFAULTS tables.</td>
</tr>
<tr>
<td>Attribute Name</td>
<td>Description</td>
</tr>
<tr>
<td>----------------</td>
<td>-------------</td>
</tr>
<tr>
<td>Attribute</td>
<td>You can associate a textbox with a database attribute by using the Select Value dialog box. If the attribute you select has a default label value, it will display in the Default Label field.</td>
</tr>
<tr>
<td>Menu Type</td>
<td>You can enter a value in the Menu Type property that links the textbox to a pre-formatted drop-down menu. The value, called a menu ID, defines the XML presentation content and format of a drop-down menu. WORKORDER, for example, is the Menu Type for the Parent WO textbox in Work Order Tracking. Menu ID's reside in a system XML file called menus.xml. You cannot edit menus.xml from Application Designer. However, you can view the content of this file or other system .xml files by selecting a main tab from Application Designer and choosing Select Action &gt; Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the &lt;maximo_root&gt;\resources\presentation\system directory.</td>
</tr>
<tr>
<td>Lookup</td>
<td>You can enter a value in the Lookup property that links the textbox to a pre-formatted lookup table. The lookup table pulls records from the main table. Users can populate the textbox by selecting a record from the table. The value, called a lookup ID, defines the XML presentation content and format of a select value table. WORKORDERISTASK, for example, is the Lookup property for the Parent WO textbox in Work Order Tracking. Lookup ID's reside in a system XML file called lookups.xml. You cannot edit system XML files from Application Designer. However, you can view the content of these types of files by selecting a main tab from Application Designer and choosing Select Action &gt; Export System XML. This action exports the library.xml, lookups.xml, and menus.xml files to the &lt;maximo_root&gt;\resources\presentation\system directory.</td>
</tr>
<tr>
<td>Detail Image</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
Input Mode Select one of options listed below for the Input Mode:

- Default
- Password
- Password Readonly
- Password Required
- Query
- Readonly
- Required

The Default option sets the Input Mode for all controls to "edit." If you do not select an Input Mode for a control, Maximo automatically sets the mode to read/write so that you can both enter or display information in the field. If you enter information in a read/write text field, it posts to the database column specified by the Attribute property.

Input Mode Option Descriptions:

**Default** – sets control to "edit" so you can display or input values and mode is read/write

**Password** – sets control to display asterisks (blanked out) for displayed or input values and mode is read/write

**Password Readonly** – sets control to display asterisks and mode is read only

**Password Required** – sets control to display asterisks and the control is required

**Query** – sets control to display a typed value and mode is read only

**Readonly** – sets control to display grayed-out text and mode is read only

**Required** – sets control to display a typed value and record cannot be saved unless there is a value in the control

**QBE Prepend**

If you set Input Mode to "Query," then you can filter the record search by adding a text string prefix that acts as filter. For example, the More Search Fields dialog uses the QBE Prepend feature to add date search filters similar to ">=". You enter the value here to save key strokes when searching for records that meet specific date criteria.
### Attribute Name | Description
--- | ---
**Change Event** | You can configure an input control to perform either of the following actions based on any data change to the control:

- **REFRESHTABLE**
- **RESETCHILDREN**

Choosing **REFRESHTABLE** forces the table that is the data source for the input control to refresh its data. Choosing **RESETCHILDREN** forces any children of the control's data bean to delete and reacquire their MBOSetRemote references.

<table>
<thead>
<tr>
<th>Turn Smart Fill Off?</th>
<th>By default, Maximo enables the &quot;Smart Fill&quot; feature. To disable, clear the check box. This feature enables you to enter a partial value in a text box field. Maximo attempts to match the partial text string entered to a valid value(s) in the database. If Maximo finds one matching value, it automatically populates the field so that you can continue entering information. If Maximo finds more than one matching value, it displays a Select Value dialog box with a list of matching values. If you clear the smart fill feature, Maximo does not validate the data you enter in the textbox.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Readonly Long Description?</td>
<td>By default, Maximo sets a Long Description associated with a textbox attribute to editable. Select this field to make the Long Description read only.</td>
</tr>
<tr>
<td>GOTO Application</td>
<td>You can configure a pull-down menu associated with a textbox to have options that will take the user to different applications. Use the Select Value dialog box for this property to choose application names that will appear in the pull-down menu.</td>
</tr>
<tr>
<td>Display Type</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Move to Data Source ID</td>
<td>The value you enter lets you move to a record stored in a different object. You can select any Data Source ID from the presentation. Refer to the Data Source ID definition below. By default, Maximo sends the Move To event to the ResultsBean, which contains a set of records displayed in the List tab. The Move To event affects the Move to Data Source ID object.</td>
</tr>
</tbody>
</table>
The Tree control is a container type of control that works with the Tree Node and Tree Attribute controls. You can use these controls to build dynamic, hierarchical tree structures in Maximo with specific MBOs, such as CLASSSTRUCTURE, that support hierarchical data. The Classifications application uses the Tree controls and the CLASSSTRUCTURE MBO to build classification hierarchies. The Security Profile hierarchy in the Users application is another example of how Maximo employs the Tree controls.

Rules

You can place the following controls in this container control:

- ▼ Tree Node

You can place this control inside the following container controls:

- ▼ Dialogs
- ▼ Tab

Example

The following Select Parent Classification tree example illustrates how the combination of Tree, Tree Node and Tree Properties controls work together to graphically display an existing hierarchical data structure in Maximo.

1. The Select Parent Classification tree structure in Application Designer workspace. To view this dialog box select Go To > Configuration >

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Data Source ID</td>
<td>The Data Source ID for this control. It points to the main MBO or object that the control uses for entering and displaying data. Each application links to a main object that represents the Parent Data Source for all child controls in the application. Individual or groups of controls within an application can inherit attributes from objects that are not the primary data source. See the Data Source ID description for the Combobox control for additional information on data sources.</td>
</tr>
</tbody>
</table>
Application Designer > ASSETCAT > Select Parent Classification dialog.

2 Tree Properties dialog box for Select Parent Classification in Application Designer workspace.
3 Tree Node Properties dialog box for Select Parent Classification in Application Designer workspace.

4 Tree Attribute Properties dialog box for Select Parent Classification with CLASSIFICATION attribute in Application Designer workspace.

5 Tree Attribute Properties dialog box for Select Parent Classification with CLASSIFICATION.DESCRIPTION attribute in Application Designer workspace.
6. The Administration > Classifications > Parent Classification > Select Parent Classification dialog box with data structure in the Maximo user interface.

![Select Parent Classification dialog box]

**Properties**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Height</td>
<td>Enter a numeric value in this field that will increase or decrease the height of this control.</td>
</tr>
<tr>
<td>Width</td>
<td>Enter a numeric value to increase or decrease the width of this control.</td>
</tr>
<tr>
<td>Bean Class</td>
<td>Reserved for future use.</td>
</tr>
</tbody>
</table>
Tree Attribute

The Tree Attribute control describes the type of data that appears in each Tree Node. For example, the tree attributes in the Classifications tree structure are responsible for displaying Classification IDs and Descriptions in the user interface. The following XML shows how the Tree Attribute controls point to ID and Description data attributes in the Classifications presentation:

```xml
<treeattribute id="selectParentClassification_tree_node1_attr1" dataattribute="classificationid" display="true" />
<treeattribute id="selectParentClassification_tree_node1_attr2" dataattribute="classification.description" display="true" />
```

Rules

This is not a container control.

You can place this control inside the following container control:

- Tree Node

### Attribute Name | Description
---|---
Business Object | The main MBO reference for the application. For example, Work Order Tracking uses WOTRACK and Assets uses ASSET. The primary MBO for the Classifications application is CLASSSTRUCTURE.

Every Maximo application works with a MBO and MBOSet. The set of work orders displayed on the List tab in the Work Order Tracking application, for example, is a MBOSet. Each individual work order is a MBO. An application's presentation tag defines the main MBO for the application. MBOs are responsible for the following types of functions:

- Field validation
- Updating the database
- Business processing logic

Relationship | You can enter a relationship value in this field. Maximo relationships reside in the Database Configuration > Relationships tab. If you enter a relationship, it is automatically inherited by any input child controls within the tree. Relationships enable controls to display or write to different Maximo business objects.

Use Data Source? | Reserved for future use.

Order By | Reserved for future use.
**Example**

See the preceding Tree control example.

**Properties**

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Display?</td>
<td>Select this box to display the defined Attribute value in the Tree Node.</td>
</tr>
<tr>
<td>Attribute</td>
<td>You can associate what values display in the tree node structure with a database attribute by using the Select Value dialog box. To create the example for this control, you can enter &quot;=classstructure&quot; in the Object field to display all the attributes in the CLASSSTRUCTURE table. Select the &quot;CLASSIFICATIONID&quot; attribute to display Classification ID as one of the Tree Node properties. In the Tree example, you also define another Tree Attribute property called &quot;CLASSIFICATION.DESCRIPTION&quot; to display the Classification Description value.</td>
</tr>
</tbody>
</table>

**Tree Node**

The Tree Node control is a container type of control that works with the Tree and Tree Attribute controls. A Tree Node defines the structure of a hierarchical tree.

**Rules**

You can place the following controls in this container control:

- Tree Attribute

You can place this control inside the following container control:

- Tree

**Example**

See the preceding Tree control example.
# Properties

<table>
<thead>
<tr>
<th>Attribute Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control ID</td>
<td>A unique, alphanumeric identifier assigned to each control in a presentation. You cannot edit this value.</td>
</tr>
<tr>
<td>Image</td>
<td>To add a graphic next to the Tree Node, enter a file name in this field. This field defaults to the path of the images directory so that you do not have to enter the full path for a graphic file. You can specify any type of graphic that a browser is capable of displaying, such as .gif, .jpeg, or .bmps. Some graphic files may require a plug-in. <strong>NOTE</strong> You can place any graphic file into the Maximo library of images. However, if you insert a graphic file without a .gif extension into Maximo, then you need to rebuild/deploy the Maximo .EAR file.</td>
</tr>
<tr>
<td>Select Image</td>
<td>Enter the name of a graphic file here that will replace the typical blue box that appears to the right of the + (open) and – (close) images when you open a Tree Node structure.</td>
</tr>
<tr>
<td>Display Key Attribute?</td>
<td>Select this property to display the Key Attribute as part of the Tree Node label.</td>
</tr>
<tr>
<td>Display Object Name?</td>
<td>Select this property to display the Object Name as part of the Tree Node label.</td>
</tr>
<tr>
<td>Display Node Image?</td>
<td>Select this property to display the Node Image as part of the Tree Node label.</td>
</tr>
<tr>
<td>Key Attribute</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Object Name</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Key Value</td>
<td>Reserved for future use.</td>
</tr>
<tr>
<td>Return Attribute</td>
<td>Enter an attribute name whose value gets returned to the browser when you click the blue square next to a Tree Node line item.</td>
</tr>
<tr>
<td>Enable Return?</td>
<td>Select this property to enable the Return Attribute property functionality (i.e., clicking the blue square).</td>
</tr>
</tbody>
</table>
This information was developed for products and services offered in the U.S.A.

IBM may not offer the products, services, or features discussed in this document in other countries. Consult your local IBM representative for information on the products and services currently available in your area. Any reference to an IBM product, program, or service is not intended to state or imply that only that IBM product, program, or service may be used. Any functionally equivalent product, program, or service that does not infringe any IBM intellectual property right may be used instead. However, it is the user's responsibility to evaluate and verify the operation of any non-IBM product, program, or service.

IBM may have patents or pending patent applications covering subject matter described in this document. The furnishing of this document does not grant you any license to these patents. You can send license inquiries, in writing, to:

IBM Director of Licensing
IBM Corporation
North Castle Drive
Armonk, NY 10504-1785
U.S.A.

For license inquiries regarding double-byte (DBCS) information, contact the IBM Intellectual Property Department in your country or send inquiries, in writing, to:

IBM World Trade Asia Corporation
Licensing
2-31 Roppongi 3-chome, Minato-ku
Tokyo 106-0032, Japan

The following paragraph does not apply to the United Kingdom or any other country where such provisions are inconsistent with local law:

INTERNATIONAL BUSINESS MACHINES CORPORATION PROVIDES THIS PUBLICATION "AS IS" WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF NON-INFRINGEMENT, MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. Some states do not allow disclaimer of express or implied warranties in certain transactions, therefore, this statement may not apply to you.

This information could include technical inaccuracies or typographical errors. Changes are periodically made to the information herein; these changes will be incorporated in new editions of the publication. IBM may make improvements and/or changes in the product(s) and/or the program(s) described in this publication at any time without notice.

Any references in this information to non-IBM Web sites are provided for convenience only and do not in any manner serve as an endorsement of those
Web sites. The materials at those Web sites are not part of the materials for this IBM product and use of those Web sites is at your own risk.

IBM may use or distribute any of the information you supply in any way it believes appropriate without incurring any obligation to you.

Licensees of this program who wish to have information about it for the purpose of enabling: (i) the exchange of information between independently created programs and other programs (including this one) and (ii) the mutual use of the information which has been exchanged, should contact:

IBM Corporation
2Z4A/101
11400 Burnet Road
Austin, TX 78758 U.S.A.

Such information may be available, subject to appropriate terms and conditions, including in some cases, payment of a fee.

The licensed program described in this document and all licensed material available for it are provided by IBM under terms of the IBM Customer Agreement, IBM International Program License Agreement or any equivalent agreement between us.

Information concerning non-IBM products was obtained from the suppliers of those products, their published announcements or other publicly available sources. IBM has not tested those products and cannot confirm the accuracy of performance, compatibility or any other claims related to non-IBM products. Questions on the capabilities of non-IBM products should be addressed to the suppliers of those products.

All statements regarding IBM's future direction or intent are subject to change or withdrawal without notice, and represent goals and objectives only.

This information contains examples of data and reports used in daily business operations. To illustrate them as completely as possible, the examples include the names of individuals, companies, brands, and products. All of these names are fictitious and any similarity to the names and addresses used by an actual business enterprise is entirely coincidental.

If you are viewing this information softcopy, the photographs and color illustrations may not appear.

**Trademarks**

AIX, IBM, IBM Corporation, the IBM logo, Tivoli, and WebSphere are registered trademarks of the International Business Machines Corporation in the United States, other countries, or both.

Intel, the Intel logo, and Pentium are registered trademarks of the Intel Corporation in the United States, other countries, or both.

Microsoft, Windows, and Internet Explorer are registered trademarks of Microsoft Corporation in the United States, other countries, or both.

Java and all Java-based trademarks and logos are trademarks or registered trademarks of Sun Microsystems, Inc. in the United States, other countries, or both.
Sun, Sun Microsystems, the Sun logo, and Solaris are trademarks of Sun Microsystems, Inc.

Linux is a trademark of Linus Torvalds in the United States, other countries, or both.

UNIX is a registered trademark of The Open Group in the United States and other countries.

Other company, product, and service names may be trademarks or service marks of others.
application
    how to link from a text field 1-44
application bar (appbar)
    properties table B-2
    reference information B-1
Application Designer
    adding assetcomment attribute 1-14
    adding buttons and menu items 1-37
    adding security options 1-37
    assigning a default label value 1-38
    controls
        defined 1-2
        controls overview B-1
    creating a new tab 1-35
    creating application restrictions 1-32
    creating new application types 1-33
    defining a table’s default filter 1-40
    defining field default values 1-39
    deleting user-created applications 1-35
    duplicating applications 1-33
    exporting multiple applications 1-43
    linking to an application from a text field 1-44
    linking to an external URL 1-43
    list of signature security options A-1
    modifying application dialogs 1-41
    moving controls across applications 1-42
    moving controls across tabs 1-41
    moving user interface configurations across servers 1-43
    optimizing field placement 1-37
    overview 1-1
    presentation XML 1-3
    restricting field sizes 1-36
    setting up an environment 1-5
    usage rules and recommendations 1-6
    user interface 1-1
    using the Go To menu 1-44
application restrictions
    filtering records with Application Designer 1-32
applications
    exporting with Application Designer 1-43
ASSET object
    adding assetcomment attribute 1-14
    assetcomment
        add textbox using Application Designer 1-17, 1-20
    attachments
        properties table B-3
        reference information B-2
attributes
    adding assetcomment textbox to Assets 1-17
    adding assetcomment textbox to Work Order Tracking 1-20
    adding assetcomment to ASSET object 1-14
    adding textbox for assetcomment in Assets 1-14
    adding woassetcomment textbox to Work Order Tracking 1-29
    adding woassetcomment to WORKORDER object 1-26

blank line
    properties table B-4
    reference information B-3
button group
    properties table B-5
    reference information B-4
buttons
    adding 1-37

checkbox
    properties table B-7
    reference information B-6
comboxbox
    properties table B-11
    reference information B-10
configDB
    configuring the Maximo database 1-15
configurations
    moving across servers 1-43
    configuring the Maximo database 1-15
controls
    application bar (appbar) B-1
    attachments B-2
    blank line B-3
    button group B-4
    checkbox B-6
    comboxbox B-10
    data source B-14
    default value B-18
    defined 1-2
    help grid B-20
    hyperlink B-22
    image B-26
    include B-28
    layout information 1-4
    list of 1-2
    listbox B-30
    menubar B-33
    moving across applications 1-42
    moving across tabs 1-41
    multiline textbox B-34
    multipart textbox B-39
    parameter value B-45
    parameter values B-47
    pushbutton B-50
    radio button B-53
    radio button group B-55
    reference information B-1
Index

section B-59
section column B-65
section header B-66
section row B-69
static text B-69
tab B-72
tab group B-75
table B-76
table column B-82
textbox B-89
tree B-94
tree attribute B-98
tree node B-99
crossover domains
  adding 1-27
  applying to a field 1-29
  applying to an object 1-26
  creating 1-26
  documentation scenario 1-10
  overview 1-8
  some examples of 1-9
  user scenario overview 1-23
customer support ii-v

data fields
  optimizing placement 1-37
data source
  properties table B-16
  reference information B-14
database
  configuring 1-15
database relationships
  linking objects 1-16
  some examples of 1-9
default value
  properties table B-19
  reference information B-18
default values
  defining with Application Designer 1-39
deleting
  user-created applications 1-35
dialogs
  modifying with Application Designer 1-41
  duplicating
  applications with Application Designer 1-33

E

events of
  crossover domains and database relationships 1-9
export
  presentation XML 1-4

G

Go To menu

H

help grid
  properties table B-22
  reference information B-20
How To
  add a value list to a field 1-6
  add buttons and menu items 1-37
  assign or override the default label value 1-38
  create a new tab 1-35
  create application restrictions 1-32
  create new applications 1-33
  define a default filter for a table 1-40
  define field default values 1-39
  define security options for an application 1-37
  delete a user-created application 1-35
  duplicate an application 1-33
  export applications 1-43
  link to an application from a text field 1-44
  link to an external URL 1-43
  move controls across applications 1-42
  move controls across tabs 1-41
  move user interface configurations across servers 1-43
  optimize field placement for data entry 1-37
  restrict field sizes 1-36
hyperlink
  properties table B-24
  reference information B-22

I

image
  properties table B-27
  reference information B-26
import
  presentation XML 1-4
include
  properties table B-30
  reference information B-28
input fields
  restricting size 1-36

L

linked objects
  documentation scenario 1-10
  overview 1-8
  user scenario overview 1-12
linking
  WORKORDER and ASSET objects 1-16
listbox
  properties table B-31
  reference information B-30

IBM Maximo: Application Designer Quick Start Guide
M

menu items
  adding 1-37
menubar
  properties table B-34
  reference information B-33
monitor
  recommended resolution 1-5
multiline textbox
  properties table B-36
  reference information B-34
multipart textbox
  properties table B-41
  reference information B-39

O

objects
  linking via database relationships 1-16
online support ii-v
overview
  Application Designer 1-1
overview
  controls reference information B-1
  crossover domains scenario 1-23
  linked objects and crossover domains 1-8
  linked objects user scenario 1-12

P

parameter value
  properties table B-46
  reference information B-45
parameter values
  properties table B-48
  reference information B-47
presentation XML
  defined 1-3
  editing at a system level 1-4, 1-5
  how to import and export 1-4
  how to modify 1-4
properties table
  application bar (appbar) B-2
  attachments B-3
  blank line B-4
  button group B-5
  checkbox B-7
  combobox B-11
  data source B-16
  default value B-19
  help grid B-22
  hyperlink B-24
  image B-27
  include B-30
  listbox B-31
  menubar B-34
  multiline textbox B-36
  multipart textbox B-41
  parameter value B-46
  parameter values B-48
  pushbutton B-51
  radio button B-54
  radio button group B-57
  section B-61
  section column B-66
  section header B-68
  section row B-69
  static text B-71
  tab B-73
  tab group B-75
  table B-77
  table column B-83
  textbox B-90
  tree B-97
  tree attribute B-99
  tree node B-100
pushbutton
  properties table B-51
  reference information B-50
radio button
  properties table B-54
  reference information B-53
radio button group
  properties table B-57
  reference information B-55

S

scenarios
  for linked objects and crossover domains 1-10
section
  properties table B-61
  reference information B-59
section column
  properties table B-66
  reference information B-65
section header
  properties table B-68
  reference information B-66
section row
  properties table B-69
  reference information B-69
security
  adding or modifying options 1-37
  list of signature options A-1
servers
  moving user interface configurations 1-43
static text
  properties table B-71
  reference information B-69
support, online ii-v
Index

T

tab
  properties table B-73
  reference information B-72

tab group
  properties table B-75
  reference information B-75

table
  defining a default filter 1-40
  properties table B-77
  reference information B-76
	table attribute
  properties table B-99

table column
  properties table B-83
  reference information B-82

tabs
  creating with Application Designer 1-35

text field
  linking to an application 1-44

textbox
  properties table B-90
  reference information B-89

textbox control
  assigning a default label value 1-38
  overriding the default label value 1-38, 1-39

tree
  properties table B-97
  reference information B-94
	tree attribute
  reference information B-98
	tree node
  properties table B-100
  reference information B-99

U

URL
  linking to an external site from an application 1-43

user
  scenarios
    for linked objects and crossover domains 1-10

user interface
  Application Designer 1-1

V

value list
  adding with the Application Designer 1-6

W

woassetcomment
  add textbox using Application Designer 1-29

WORKORDER object
  adding woassetcomment attribute 1-26